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Important Safety Instructions

. READ INSTRUCTIONS - Read the instruc-
tions carefully before using this product.

. RETAIN INSTRUCTIONS - Retain the
instructions for future reference.

. HEED WARNINGS - Observe warnings listed
in the manual.

. FOLLOW INSTRUCTIONS - Follow the
instructions when using this product.

. CLEAN - Use a dry cloth for cleaning.

. VENTILATION - Do not block any ventilation
openings of this product

. MOISTURE - Do not use this product near
water, and be sure to prevent this product from
being exposed to any dripping or splashing.

. HEAT - Do not install this product near any
heat sources, such as radiators, heat registers,
stoves or other devices (including amplifier)
which produce heat.

. POLARIZATION - Do not defeat the safety

purpose of the polarized or grounding-type plug.

A polarized plug has two blades with one wider
than the other. A grounding type plug has two
blades and a third grounding prong. The wide
blade or the prong are provided for your safety.
If the provided plug does not fit into your outlet,
consult an electrician for replacement of the
obsolete outlet.

10.POWER CORD - Protect the power cord from

being walked on or pinched, particularly at
plugs, convenience receptacles and the point
where they exit from the product.

11.ACCESSORIES/ATTACHMENTS - Use

only accessories/attachments specified by the
manufacturer.

12.USAGE - Unplug this product during lightning

storms or when it is not used for long periods of
time.

13.CART - Use only cart, stand, tripod bracket

or table specified by the manufacturer or sold
with the product. When a cart is used, operate
carefully to prevent the objects from tip-over.

14.SERVICING - Contact qualified personnel

when servicing is needed. Servicing is required
when this product has been damaged in any way,
for example, when the power cord or plug is
damaged; liquid has been spilled on the product;
objects have fallen into the product; the product
has been exposed to rain or moisture; the
product does not work normally; or the product
has been dropped.

15.BATTERY - To prevent battery leakage which

may result in bodily injury, property damage or
damage to the unit, please follow the instruc-
tions listed below when using the product’s
remote control.

* Install all batteries correctly, with + and - signs
matching the marks indicated.

* Do not mix batteries (old and new or carbon
and alkaline, etc.)

* Remove batteries when the remote is not used
for a long time.

16.ENVIRONMENTAL NOTE - This product has

been made from high-quality parts and materials
which can be re-used and recycled.

Therefore, do not throw the product away with
normal household waste at the end of its life.
Take it to a collection point for recycling electri-
cal and electronic devices. This is indicated by
this symbol on the product, in the operating
manual and on the packaging.

Please find out about collection points operated
by your local authority.

Help protect the environment by recycling used
products.
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Warnings, Cautions and Others

SHOWVIEW

SHowVIew is a registered trademark of Gemstar Develop-

RISKDOS %LE%EEHOCK ment Corporation. The SHowView system is manufactured
under license from Gemstar Development Corporation.
CAUTION!

TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT
REMOVE THE COVER OF THIS UNIT. THERE ARE NO
USER SERVICEABLE PARTS INSIDE. REFER SERVIC-

ING TO QUALIFIED SERVICE PERSONNEL.

The lighting flash with arrowhead
symbol, within an equilateral triangle,
is intended to alert the user to the
presence of uninsulated ‘dangerous
voltage’ within the product enclosure
that may be of sufficient magnitude
constitute a risk of electric shock to
humans.

The exclamation point within an
equilateral triangle is intended to alert
the user to the presence of important
operating and maintenance
(servicing) instructions in the
literature accompanying the
appliance.

PRODUCTS WITH 525P/625P PROGRESSIVE SCAN
OUTPUTS NOTICE REQUIREMENTS

“CONSUMERS SHOULD NOTE THAT NOT ALL

HIGH DEFINITION TELEVISION SETS ARE FULLY
COMPATIBLE WITH THIS PRODUCT AND MAY CAUSE
ARTIFACTS TO BE DISPLAYED IN THE PICTURE. IN
CASE OF 525 OR 625 PROGRESSIVE SCAN PICTURE
PROBLEMS, IT IS RECOMMENDED THAT THE USER
SWITCH THE CONNECTION TO THE ‘STANDARD
DEFINITION’ OUTPUT. IF THERE ARE QUESTIONS
REGARDING OUR TV SET COMPATIBILITY WITH
THIS MODEL 525P AND 625P DVD PLAYER, PLEASE
CONTACT OUR CUSTOMER SERVICE CENTER.”

IMPORTANT FOR LASER PRODUCTS

1. CLASS 1 LASER PRODUCT

2. DANGER: Visible and invisible laser radiation when
open and interlock failed or defeated. Avoid direct
exposure to beam.

3. CAUTION: Do not open the top cover. There are no
user serviceable parts inside the Unit; leave all servic-
ing to qualified service personnel.

CAUTION!

THIS PRODUCT UTILIZES A LASER.USE OF
CONTROLS OR ADJUSTMENTS OR PERFORMANCE
OF PROCEDURES OTHER THAN THOSE SPECIFIED

HEREIN MAY RESULT IN HAZARDOUS RADIATION
EXPOSURE. DO NOT OPEN THE COVER AND DO NOT
REPAIR YOURSELF. REFER SERVICING TO
QUALIFIED SERVICE PERSONNEL.

WARNING:

TO REDUCE THE RISK OF FIRE, ELECTRIC SHOCK
OR PRODUCT DAMAGE, DO NOT EXPOSE THIS APPA-
RATUS TO MOISTURE AND ENSURE THAT OBJECTS
FILLED WITH LIQUIDS, SUCH AS VASES, SHALL BE
PLACED AWAY FROM THE APPARATUS.

CAUTION!
CD-R/RW discs recorded using a personal computer or
a CD Recorder may not play if the disc is damaged or
dirty, or if there is dirt or condensation on the player lens.
Unfinalized CD-R/RW discs can be played, but not all
time information (playing time, etc.) will be displayed.
Check the copyright laws in your country before record-
ing from DVD VIDEO, SVCD, Video CD, Audio CD, MP3
and JPEG discs. Recording of copyrighted material may
infringe copyright laws.

CAUTION! — O POWER button
Disconnect the main plug to shut the power off completely.
The POWER button in any position does not disconnect
the main line. Power can be controlled from the remote.

Legal Notices Regarding

Macrovision Property Rights
“U.S. Patent Nos. 4,631,603; 4,577,216; 4,819,098;
4,907,093; and 6,516,132.”
“This product incorporates copyright protection technology
that is protected by U.S. patents and other intellectual
property rights. Use of this copyright protection technology
must be authorized by Macrovision, and is intended for
home and other limited viewing uses only unless otherwise
authorized by Macrovision. Reverse engineering or
disassembly is prohibited.”




Manufactured under license from Dolby Laboratories.
‘Dolby’ and the double-D symbol are trademarks of Dolby
Laboratories.

This symbol indicates that used
electrical and electronic equipment
requires special handling when

the unit is to be discarded. Please
send the unwanted unit to a waste
collection/recycling center near you

_ to help protect our environment.

LLLIBLERZN DivX, DivX Certified, and associated

D|\/)@ logos are trademarks of DivXNet-

CERTIFIED works, Inc. and are used under
P ™ license.
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Using the Manual

Icons Used in Manual

The following icons are used in the manual for
special notice and additional information.

Icon Text Definition

' Used to indicate the
& Before you start...

Used to indicate
exceptions and

checklist section
@ Note
additional notices

Used to indicate
related sections/chap-
ters

\A Reference

Used to explain

About particular terms in
text
. Used to offt
Why This > 0(.) " .
explanation/solution

Happened

to specific conditions.

Used to remind users
before applying a
particular function

What You Need
to Do process overview

Used to present a

£
@
1 | imporiam
ik

Gietting Help

Using the Manual

Please see the ‘Quick Reference’ section at the

« end of this manual, if you need the complete
listings of system setup menu and the support-
ing disc types of this DVD recorder.

Please see the ‘Specifications’ section, if you
« need a fast overview of this DVD recorder.

Please see the ‘Troubleshooting’ section, if

« you encounter problems when using this DVD
recorder. Solutions listed in this section might
help fix your problems instantly.




Features

Recording

This DVD recorder offers a fast and easy way for
you to record your desired TV programs.

One-Touch Recording

This DVD recorder features an easy instant record-
ing capability. Start recording whenever you want
by pressing ® RECORD on your remote control.
Pressing the button repeatedly will also give you a
choice of different recording length, further saving
you the trouble to enter specific time.

(S~ .
"\, One-Touch Recording (p.49)

Flexible Recording Choices

This DVD recorder supports various recording
modes, each of which offers different recording
length and image quality. You can choose one of
these options depending on your discs and record-

ing purpose.

Media Mode Rec. Time
4.7 GB HQ (High Quality) 1 hour
Recordable

& Rewritable | SP (Standard Play) | 2 hours

DVD LP (Long Play) 3 hours

EP (Extended Play) | 4 hours

SLP (Super Long 6 hours
Play)

Just Fit* Depending on the
storage capacity
available on disc

* For ‘Timer Recording’ only
, Using Easy Guider: Record (p.35)

4 Recording (p.45)

Timer Recording

There is no need to worry about missing your
favorite TV programs. With the timer recording
function offered by this DVD recorder, you can
easily input up to 32 settings in the Timer Program
list to record your desired programs. To each set-
ting, you can assign particular recording mode and
recording frequency (Once/Daily/Weekly) which
best suit your need.

// Using Easy Guider: Timer Record (p.36)

I . .
) Timer Recording (p.51)

Easy Guider

This DVD recorder comes with an integrated ‘Easy
Guider’ program, which is an on-screen interface
specially designed to help you complete desired
tasks step by step.

S .
\\, Easy Guider (p.32)

AllWrite ™ Technology

Built with the AllWrite™ technology, this DVD
recorder is able to write on almost all types of
recordable and rewritable discs (CD-R/RW,
DVD-R/RW, DVD+R/RW), giving users greater
recording flexibility.

(l, Guide to Using the Discs (p.93)
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High Storage Capacity

With an integrated hard drive, this DVD recorder
offers you capacity and flexibility for performing
a number of functions, such as recording, copying
and timer recording. Make use of this built-in
device to record your favorite shows; convert your
home videos to discs; or create a copy of your
digital photo albums.

MPEG-4 Videos

Now you can play MPEG-4 videos on this DVD
recorder and enjoy a better viewing experience
with your TV!

(%, Digital Video Support (p.68)

DivX" VOD Support

This DVD recorder supports the DivX® VOD
(video-on-demand) service, a feature designed to
protect the copyrights of digital videos. You can
now easily watch videos downloaded from the
online rental shops with your TV!

4 DivX® VOD (p.71)




DVD Recording: The Essentials

DVD recorders not only offer the basic recording and playback functions as the traditional VCRs (video casette
recorders) do, but also make convenient content-sharing possible. Now you could play a finalized disc on other
compatible DVD players as well as on PCs. The following sections introduce the basics of DVD recording,
which may help you make the most of your recorder.

» What to Choose

Unlike the traditional VCR, DVD recorder comes with a wider variety of recordable media to choose
from. Depending on different technologies employed, recordable DVD discs are divided into two major
categories: the ‘minus (-)” and ‘plus (+)’ formats. Within these two groups, discs are further classified by
their ‘rewritability’. Recordable (+R or -R) discs can be used for recording only once, which means that
you will not be able to write anything into a section already used. Rewritable (+RW or -RW) discs, on the
other hand, allow users to erase recordings and then to add new ones to the same section repeatedly.

Format Rewritability Disc Type
Recordable (Write-Once) Q) ovor
Minus (-)
Rewritable DVD-RW
Recordable (Write-Once) ) ovoiR
Plus (+)
Rewritable (0]

* Before buying discs, please check what types of discs are supported by your DVD recorder.

» How to Record

Using DVDs to record is similar to what you do with videotapes, except that you may need to prepare
your blank disc in a certain format. This formatting process varies depending on your recorder and the disc
you use. To record, insert a suitable disc to the recorder, and select a recording mode if necessary. When
preparation is done, press ® RECORD on the unit or the remote control to start recording.

» How to Play

When the recording is finished, press » PLAY to view the recorded programs or titles. A disc menu may
appear: use « v 4 » to select your desired program or title. If you would like to play the recordings on
other DVD players or PCs, you need to finalize the disc first, unless you have used a DVD+RW disc.

SIPYUaSST Y 3UIp1023y A P N



Gettin
Starte

his chapter introduces basic system

setups for the DVD recorder. Please
follow the steps listed below to complete
these requirements for further application.

Setting up the DVD Recorder................... 8
* Knowing Your DVD Recorder................ 9
» Connecting up Your DVD Recorder......... 12
System Setup...o.ooiviiii 15
e Sefting lLanguage............ccoeevevvennnnn. 16
» Setting System Date......................... 16
« Setting System Time........................ 17
» Setting Video Output..........c.coeeennin. 17
e Setting Audio Output................oeenie. 18
» Setting Aspect Ratio......................... 19
e Setting TV Channels..................oo... 19
Advanced System Setup......................... 21
* Using Channel Editor.................o.o... 21

» Setting the ShowView® System............. 26

Setting up the
DVD Recorder

The following sections introduce a step-by-step
process to set up this DVD recorder. When more
than one setup option are listed at a specific stage,
please refer to the option most suitable for your
setup condition.

Before you start...

Check whether all the accessories are included
« in your package box.

[ ] Remote Control (1)
[ ] Batteries (2)
[] Audio/Video Cable (1)

[ ] Power Cord (1)
(Not available in all models)

[] Antenna Cable (1)

[] SCART Cable (1)
(Not available in all models)

[] User’s Manual (1)




Knowing Your DVD Recorder

Front-Panel Connections

= | =

1. POWER ON/OFF button 8. STOP button
Switches the DVD recorder on and off Stops playback or recording
2. Disk tray 9. HDD/DVD button
Holds discs securely during recording or Chancges DVD recorder’s current mode from
playback HDD (hard disk drive to DVD and vice versa
3. HDD indicator 10. RECORD button
Shows the current target device of DVD Starts recording
recorder
11. SOURCE button
4. DVD indicator Selects equipment connected via line inputs
Shows the current target device of DVD
recorder 12. DV-LINK (IEEE 1394) jack

Connects digital camcorder
5. DISPLAY window

Shows operation informtion 13. LINE IN (Composite-VIDEO/AUDIO L/R)
jack
6. EJECT button Connects the outputs of external equipment via
Opens or closes the disc tray composite video/audio cables

7. PLAYBACK button
Starts the playback

pa140)S Su1j1oL) y N



Display Window

2
(10 il
m/ TIMER

—eaanan

DvVD SVCD VCD CDDA FILE

1. PLAY indicator
2. DVD indicator
3. SVCD indicator
4. VCD indicator

5. CDDA indicator

7. CD indicator

8. DVD+R indicator
9. PAUSE indicator
10.RECORD indicator

11.TIMER RECORD
mode indicator

12.Multi-information
window

13.DVD+RW indicator

14.CD-R/DVD-R
indicator

15.CD-RW indicator

6. FILE indicator

Rear-Panel Connections

1. VHF/UHF IN/OUT jacks
Connects antenna cables

2. SCART IN jack
Connects the output of external equipment via
SCART cable

3. SCART OUT jack
Connects the input of external equipment via
SCART cable

4. AV OUTPUT (VIDEO/AUDIO L/R) jacks
Connects the inputs of external equipment via
composite video/audio cables

. COMP OUT (COMPONENT) jacks
Connects the inputs of external equipment via
component video cables

. DIGITAL OUT (OPTICAL) jack

Connects an amplifier or a receiver having a
digital input jack

. DIGITAL OUT (COAXIAL) jack

Connects an amplifier or a receiver having a
digital input jack

. AC IN terminal

Connects the power cord

10



Remote Control

1. DISPLAY button
Press to view information

2. A OPEN/CLOSE button
Press to open or close the
disc tray

3. Alphabet and Number
buttons
Press to enter numbers and
characters

4. GUIDER button
Press to display Easy Guider
menu

5. SOURCE button
Press to select signal source

6. ~ v < » (direction) and
ENTER buttons
Press to make selection

7. TOP MENU button
Press to display disc's top
menu

8. m STOP button
Press to stop playback or
recording

9. «« REW button
Press to reverse playback

10. «« PREVIOUS button
Press to go to previous
file/picture/track/title

11. NAVI. button
Press to display Navigation
menu

12. @ RECORD button
Press to start recording

13. EDIT button
Press to display Edit menu

14. HDD/DVD button
Press to switch between
HDD and DVD mode

|

-

|
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15. SETUP button
Press to display the System
Setup menu

16. ® POWER button
Press to switch on or off the
recorder

17. CH a/CH ~ buttons

Press to select channel

18. CONTENTS button
Press to display the Con-
tents Menu

19. TV/MODE button
Press to switch between TV
source and SCART source

20. MENU button
Press to display disc’s menu

21. » PLAY button
Press to start playback

22.lIPPAUSE/STEP button
Press to pause playback or
recording

23. » FFW button
Press to advance playback

24. wi NEXT button
Press to go to next file/pic-
ture/track/title

25. TIME SHIFT button
Press to perform the ‘Time
Shift’ function

26. TIMER button
Press to display Timer
Record menu

27. COPY button
Press to start instant

copying

28. ShowView button
Press to display the
ShowView® timer recording
menu

11
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Using Remote Control

Preparing the Remote Control

Open the battery compartment and insert the
batteries. Make sure the polarities (+ and -) match
the markings inside the remote control.

| (Note.

» Using rechargeable batteries is not recommended.

Remote Control Signal

The remote has an operating range of approxi-
mately 7 M, and works best when pointed directly
at the unit horizontally at angle up to 30° from the
sensor window of the DVD recorder.

Easier Application with Remote Control

Function buttons, such as GUIDER or TIMER,
are designed to offer you a quick access to intended
applications. Press these buttons to go directly to
their individual menus and complete your desired
tasks. If you would like to quit an application,
simply press the designated button again.

Gonnecting up Your DVD
Recorder

Before you start...

Do not plug the AC power cord into the outlet
« until all other connections are made.

It is recommended that you connect VIDEO

« OUT jack of the DVD recorder directly to the
video input of your TV. Connecting VIDEO
OUT jack of this recorder to a TV viaa VCR
may cause a viewing problem when playing
a copy-protected disc. The same viewing
problem may also occur when connecting the
recorder to a TV/Video combo system.

%What You Need to Do:

Step 1: Connecting Antenna/Satellite Cable
Step 2: Connecting the Video Cable

Step 3: Connecting the Audio Cable

Step 4: Connecting the Decoder (If Required)

Step 5: Connecting the Power Cord

Step 1: Connecting
Antenna/Satellite Cables

Wall Outlet IDVD Recorder 0TV

1. Use an antenna cable to connect the RF IN jack
on the DVD recorder to the antenna outlet on
the wall.

2. Use an antenna cable to connect the RF OUT
jack on the DVD recorder to the RF IN jack on
the television. (Please note that this serves as a
pass-through only.)

12



Step 2: Connecting the
Video Cable

Option 1 Using SCART Cable

Use a SCART cable to connect the SCART OUT
jack on the DVD recorder to the SCART IN jack on
the television.

SCART IN
R

SCART ouT

Option 2 Using Component Cable

Use a component video (with green, blue and red
ends) cable to connect the COMPONENT OUT
jack on the DVD recorder to the COMPONENT IN

jack on the television.

CBIPBc

CR/PR C‘_ ‘:CDI'DJ Component video cable—s

COMPONENT IN
TV

CB/PB
CR/PR C
| (INote.

* If your television supports ‘Progressive Scan’
mode, you may adjust the ‘Video Output’
setting accordingly for better results. Please go
to SetupSystemVideo Output, and select
‘Progressive’. You can activate the Setup menu
directly by pressing SETUP button on your
remote control.

Step 3: Connecting the
Audio Cable

Option 1 Connecting to a TV using SCART Cable

Use a SCART cable to connect the SCART OUT
jack on the DVD recorder to the SCART IN jack on
the television.

SCART IN

Option 2 Connecting to a Stereo Audio Amplifier
or Receiver

Use the audio (red and white) ends of a composite
cable to connect the AUDIO OUT jack on the DVD
recorder to the AUDIO IN jack on a stereo ampli-
fier or a receiver.

I @ |@

R@—
Lo
vibeo ©

® e

®

Audio cable —

Stereo audio amplifier
or receiver

Option 3 Connecting to a Digital Audio Device

3.1 Using an Optical Cable

Use an optical cable to connect the DIGITAL OUT
(OPTICAL) jack on the DVD recorder to the digital
optical input on a stereo amplifier or a receiver.

13

payinis Suijjon ‘



OPTICAL COAXIAL

|

Optical digital cable —

IN I
OPTICAL@_

COAXIAL

Digital Out (Optical)

DIGITAL AUDIO DEVICE

3.2 Using a Coaxial Cable

Use a coaxial cable to connect the DIGITAL
OUT (COAXIAL) jack on the DVD recorder to
the coaxial digital input on a stereo amplifier or a
receiver.

OPTICAL COAXIAL

Coaxial digital cable —,

IN
OPTICAL
coaxiAL| @ “Chm——’

Digital Out (Coaxial)

DIGITAL AUDIO DEVICE

Step 4: Connecting the
Decoder (If Required)

For PAY-TV/CANAL-+ subscribers, you will
need to connect an additional decoder to your
TV and DVD recorder.

1. Use an antenna cable to connect the RF IN jack
on the DVD recorder to the antenna outlet on
the wall.

2. Use an antenna cable to connect the RF OUT
jack on the DVD recorder to the RF IN jack on
the television.

3. Use a SCART cable to connect the SCART IN
jack on the DVD recorder to the SCART OUT
jack on the CANAL+ decoder.

4. Use a SCART cable to connect the SCART OUT
jack on the DVD recorder to the SCART IN jack
on the television.

RFIN SCARTIN

9
1

SCART (= 1—
pral e 7

CANAL+ Decoder

oOC—310

(WMJMM N
SCART OUT

* During recording, if you have problem watching
programs imported via decoder, you can press
TV/MODE to switch to the ‘SCART Bypass’
mode. However, you need to first activate the
feature through SetupUTV Tuner 0TV MODE.

A, Setting TV MODE/SCART Bypass (p.26)

* Depending on the cable manufacturers, the
SCART cable you use may not be able to detect
all signals transferred via this connection. If
you have activated the ‘SCART Bypass’ mode
through the Setup menu, and still have problem
using the feature, please try to use a new SCART
cable to connect the decoder to your DVD
recorder.

14



Step 5: Connecting the
Power Cord

Connect the power cord to the DVD recorder. After
all the cable connections are completed, you can
now plug the power cord of the recorder into the
outlet, and start using the recorder.

System Setup

Use the Setup menu to quickly complete basic
system settings before using the DVD recorder. If
you wish to exit the Setup menu at any time, simply
press the SETUP button again.

Each option icon on the Setup menu represents
an entry point to more detailed system setup lists.
Please use ~ v < » buttons on your remote
control to make selection, and confirm it with the
ENTER button.

*/ Guide to Complete System Setup Menu (p.90)

SETUP Recording

Mode SP HQ

Chapter Mark 5 minutes o SP

@ Front AV Composite LP

Before you start...

Check whether the video signal from this
« DVD recorder is correctly displayed on your
TV screen.

// Connecting up Your DVD Recorder (p.12)

15
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Setting Language

Press SETUP to display the Setup menu.

Press a + to select ‘Language’, then press
ENTER.

SETUP

Language

0sD English

Menu English
Audio English

Subtitle English

(o]
[S]
[e~]

i

If you would like to change the language
displayed on the screen, press « v to select
‘OSD’ (on-screen display), then press ENTER
or »to go to the sub-menu.

If you would like to change the language
displayed on the menu page, press « v to
select ‘Menu’, then press ENTER or » to go
to the sub-menu.

If you would like to change the spoken
language in the video files, press « v to select
‘Audio’, then press ENTER or » to go to the
sub-menu.

If you would like to change the language
shown for the subtitle, press « v to select
‘Subtitle’, then press ENTER or » to go to the

sub-menu.
SETUP __ ianquage
Lo -~
0sD English English
G Menu English FEEPT
@ Audio English ﬁﬁ%q’y
Subtitle English Francais
)
Deutsch
@ Italia
Espanal
Nederlands
x] -

Press a v to select your desired language,
then press ENTER.

SETUP

LANGUAGE

a

0sD English ® English
FEgPX
EHAPX

Francais

Menu English

Audio English

Subtitle English
Deutsch
Italia
Espanal

Nederlands
v

When completed, press 4 to return to the main
menu.

E Press 4 or SETUP to completely exit the
Setup menu.

| (INote.

* Available language versions vary depending on
model types.

 For the ‘Menu’, ‘Audio’ and ‘Subtitle’ options,
the selected preference is applicable only when
the discs being played have the desired language
versions.

Setting System Date

Press SETUP to display the Setup menu.

Press a v to select ‘System’, then press
ENTER.

Press a v to select ‘Date’, then press EN-
TER.

Press a v < » or number buttons (0-9) to
enter correct date, then press ENTER to
confirm the entry.

SETUP

System

Video Output Date/Month/ Year

B2/02/2005

Component

D/M/Y 12Hr

Clock Format

@ Date 22/02/2005
Time 5:50:30PM
Auto Sleep 120 minutes

@ Restore ~ ceeeeeee--

If you decide not to change the date, press 4 to return
to the upper-level options.

When completed, press ¢ to return to the main
menu.

E Press 4 or SETUP to completely exit the
Setup menu.

* This DVD recorder allows users to enter date up
to 31/12/2099 (December 31, 2099). Date beyond
this day CANNOT be set.

* If you would like to change the date display
format (e.g. 2005/04/01 or 01/04/2005), please
make the adjustment through Setup 0 System
0 Clock Format.
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Setting System Time

Press SETUP to display the Setup menu.

Press a v to select ‘System’, then press

ENTER.
Press a ¥ to select ‘Time’, then press
ENTER.
SETUP System
Video Output Component Current Time
Clock Format D/M/Y 12Hr ES:SO:SOPM

Date
Time
Auto Sleep

Restore

[©]
[¢~]
x]

22/02/2005
5:50:30PM

120 minutes

Press - v < » or number buttons (0-9) to
enter correct time, then press ENTER to
confirm the entry.

SETUP

System

-

Video Output
Clock Format
Date

Time

C

Auto Sleep

Component
D/M/Y 12Hr
22/02/2005
5:50:30PM

120 minutes

Current Time

5:50:30PM

Restore ~  seceeeco-e-

(€]
(]

]

If you decide not to change the time, press 4 to return
to the upper-level options.

When completed, press ¢ to return to the main
menu.

E Press ¢ or SETUP to completely exit the
Setup menu.

| (INote.

 If you would like to change the time display
format (e.g. 19:00 or 07:00 P.M.), please make
the adjustment through Setup 0 System 0 Clock
Format.

Setting Video Output

Press SETUP to display the Setup menu.

Press a ¥ to select ‘System’, then press

ENTER.
Press a ¥ to select “Video Output’, then press
ENTER.
SETUP System

Video Output

Clock Format
Date

Time

Auto Sleep

Restore

[©]
(€]
=]

Component
D/M/Y 12Hr
22/02/2005
5:50:30PM

120 minutes

® Component
Scart S-Video
Scart RGB

Progressive

Press a ¥ to select ‘Component’, ‘SCART
S-Video’, ‘SCART RGB’, or ‘Progressive’,
then press ENTER.

SETUP

System

Video Output
Clock Format

Date

Time
J
Auto Sleep

Component
D/M/Y 12Hr
22/02/2005
5:50:30PM

120 minutes

©® Component
Scart S-Video
Scart RGB

Progressive

Restore ~  cecsee----

][] [2][e]

| (INote

* If you select a video output mode which is
different from what you use to connect the DVD
recorder to your TV, there will be an instant
signal loss on TV screen. If such a condition
occurs, please do not press any buttons on the
remote control or on the front panel. The DVD
recorder will return to the original mode in just a
few seconds.

When completed, press 4 to return to the main
menu.

E Press 4 or SETUP to completely exit the
Setup menu.

17

paLIDIS Su11ar) ‘



P About ‘Progressive Scan’

‘Progressive Scan’ mode differs from the ‘Inter-
laced Scan’ mode in how a video image is updated.
In ‘Progressive Scan’ mode, scan lines for an image
are refreshed in every pass and by a sequential
order. In the ‘Interlaced Scan’ mode, image is
updated by alternating sets of odd and even scan
lines.

Progressive Scan Mode:

Interlaced Scan Mode

Line 1

Line 2
Line 3

Line 4
Line 5

Line 6
Line 7
etc

[QNote|

« If you accidentally set ‘Progressive’ as the video
output mode when the DVD recorder is not con-
nected to a progressive-scan-compatible TV, you
may lose the video signal on your TV instantly.
To recover the problem, switch off the DVD
recorder, and then switch it on again. After the
DVD recorder is switched on, which takes about
30 seconds, press » (right direction button), 5, 0,
2, 0, on remote control, then press ENTER. The
recorder will then be automatically switched off.
The DVD recorder’s TV output will be restored
to default when you switch on the recorder next
time.

Setting Audio Output

Press SETUP to display the Setup menu.

Press a ¥ to select ‘Audio’, then press
ENTER.

SETUP __ audo
Digital Output Bit Stream PCM
DTS Out off ® Bit Stream
Surround Dolby
TV Audio Stereo
MPEG PCM

If you would like to change digital audio
output mode, press « v to select ‘Digital
Output’, then press ENTER.

¢ Select ‘PCM’ when your amplifier does not have
an integrated Dolby Digital decoder.

¢ Select ‘Bit Stream’ when your amplifier has an
integrated Dolby Digital decoder.

If you would like to enable/disable the DTS
(Digital Theater System) supporting feature
offered by your discs, press « ¥ to select
‘DTS Output’, then press ENTER.

¢ Ifthe spoken language of your disc(s) is
recorded using the DTS format, disabling
the DTS option will result in loss of sound
when watching film. Please always check the
information on disc(s) before you decide to
change options.

If you would like to change the surround-sound
setting, press « v to select ‘Surround’, then
press ENTER.

¢ This category allows you to set the playback
priority when the disc being played offers more
than one audio format for a single language.

E If you would like to change the TV audio
output mode, press « ¥ to select “TV Audio’,
then press ENTER.

¢ This category allows you to select your
preferred audio channel when watching TV pro-
grams through the DVD recorder; however, your
preference is applicable only when the selected
audio channel is offered. Meanwhile, please
note that the setting will also determine which
audio channel to be recorded for your desig-
nated TV programs. For bilingual programs,
only one language version will be recorded.
Always select ‘SAP (Sub)’, if you would like to
record the second language channel.

If you would like to change the audio output
mode for the MPEG files, press « + to select
‘MPEG?’, then press ENTER.

¢ Select ‘PCM’when your amplifier does not have
an integrated Dolby Digital decoder.

¢ Select ‘Bit Stream’ when your amplifier has an
integrated Dolby Digital decoder.
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E When completed, press ¢ to return to the main
menu.

E Press 4 or SETUP to completely exit the
Setup menu.

Setting Aspect Ratio

Aspect ratio setting affects how video images are
presented. Select 4:3 (normal) or 16:9 (widescreen)
mode which suits your television.

Press SETUP to display the Setup menu.

Press a ¥ to select ‘Playback’, then press
ENTER.

S ETUP Playback

Aspect Ratio 4:3 L.Box 16:9 Wide

Parental Lock Off 4:3 Pan
Password Fprk ® 4:3 LBox
Slide Time 5 seconds

VCD PBC On

DivX(R)VOD oo

(€]
]

Press a ¥ to select “Aspect Ratio’, then press
ENTER.

SETUP Playback

Aspect Ratio 4:3 LBox 16:9 Wide

Parental Lock off 4:3 Pan
Password Fokkx ® 4:3 L.Box
Slide Time 5 seconds

VCD PBC On

DivX(R)VOD ~ =weeeeeees

[©]
[C]
[¢~]
]

Press a « to select “16:9 Wide’ (16:9 Wide-
screen), then press ENTER, if you connect the
DVD recorder to a widescreen (16:9) TV.

Press a v to select “4:3 L.Box’ (4:3 Letter
Box), then press ENTER, if you connect the
DVD recorder to a normal (4:3) TV.

When you play back a DVD-VIDEQ disc recorded in wide
picture format, the picture is shown with black bars at the
top and bottom.

Press a v to select “4:3 Pan’ (4:3 Pan &
Scan), then press ENTER, if you connect the
DVD recorder to a normal (4:3) TV.

—_

When you play back a DVD-VIDEQO disc recorded in wide
picture format, the picture is zoomed to fill the screen verti-
cally, and the left and right sides of the image are chopped
off. Please note that depending on the disc the picture will

be shown in the 4:3 L.Box (4:3 Letter Box) mode even if you

select the 4:3 Pan (4:3 Pan & Scan) mode.

When completed, press ¢ to return to the main
menu.

E Press 4 or SETUP to completely exit the
Setup menu.

Setting TV Channels

To record the TV program you want to watch, it
is important that you set up a list of recognizable
channels for the DVD recorder. Please follow the
steps listed below to complete the process.

fWhat You Need to Do:

Step 1: Selecting Region

Step 2: Scanning TV Channels
Step 3: Editing Listed TV Channels

payinis Suijjon y N



Step 1: Selecting Region

Press SETUP to display the Setup menu.

Press a v to select “TV Tuner’, then press
ENTER.

Press a ¥ to select ‘Country’, then press
ENTER.

SETUP

TV Tuner

a

Country Germany ® Germany

Utilities e Netherlands

Norway

Sweden

o]

Finland

-
a
3

Denmark

Switzerland

Austria
v

2

Press a w to select the region where you are
currently situated, then press ENTER.

S ETUP TV Tuner
a
Country Germany ® Germany
Utilities ~ --eeeeees Netherlands
@ Norway
Sweden
Finland
@ Denmark
Switzerland
L\ustriav

When completed, press 4 to return to the main
menu.

E Press 4 or SETUP to completely exit the
Setup menu.

* List of available countries/regions may vary
depending on model types.

Step 2: Scanning TV
Channels

Press SETUP to display the Setup menu.

Press a ¥ to select “TV Tuner’, then press
ENTER.

Press a « to select ‘Utilities’, then press
ENTER.

Press a ¥ to select ‘Scan Channel’, then press
ENTER.

SETUP

TV Tuner

Germany Stop Scan

Edit Channel

[¢]

1

The DVD recorder will start searching for available
channels.

When completed, press € to return to the main
menu.

E Press 4 or SETUP to completely exit the
Setup menu.

| (Note.

* When the ‘Scan Channel’ function is activated,
the TV channels are scanned and stored in a spe-
cific order. If your TV content provider changes
the channel listing, or if you are reinstalling this
DVD recorder, you may need to go through this
process again.

Step 3: Editing Listed TV
Channels

The automatic scanning process will list all the
available channels in a specific order. If you would
like to change the sequence, you can further edit
your preference in ‘Channel Editor’. Aside from
the channel sequence, the ‘Channel Editor’ also
allows you to rename or insert channels. For more
information about the application of ‘Channel
Editor’, please see the section ‘Using Channel
Editor’.

Press SETUP to display the Setup menu.

Press a v to select “TV Tuner’, then press
ENTER.

Press a « to select ‘Utilities’, then press
ENTER.

SETUP

TV Tuner

Country Germany Stop Scan

Utilities Edit Channel

3] @]12][e][0

20



Press a v to select ‘Edit Channel’, then press

ENTER.

CHANNEL EDITOR

Preset Channel

1| CNN News

AXN Sports

HBO

Up
Down
Insert
Swap

Rename
Disable
GCN
Decode

Frequency

2
3
4 | Discovery
5

Animax Exit

The ‘Channel Editor’ page will be displayed.

Press a + to select a channel you would like
to edit, then press ENTER.

E Press « v 4 » to select the function you
would like to apply, then press ENTER.

Advanced
System Setup

Use these options to customize your preferred
settings. You can find all these options through the
Setup menu, which can be immediately activated
by pressing the SETUP button on the remote
control.

Before you start...

Please complete the basic system settings
« introduced in the previous section first.

Using Channel Editor

‘Channel Editor’ offers users an easy-to-manage
interface to organize your TV channel list. Through
‘Channel Editor’, you can rearrange and rename
TV channels according to your own preference.

You can activate ‘Channel Editor’, using the
following paths.

1. Press SETUP to display the Setup menu.

2. Press a w to select “TV Tuner’, then press
ENTER.

3. Press a ¥ to select ‘Utilities’, then press
ENTER.

4. Press a + to select ‘Edit Channel’, then press
ENTER.

5. The Channel Editor menu will be displayed.

21
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Moving up/down TV
Channels

Press a « to sclect a channel from the list,
then press ENTER.

CHANNEL EDITOR
Up
Down
Insert
Swap
Rename
Disable
Preset Channel GCN
1 [ CNN News GCN
2 | AXN Sports Decode
2 :BO Frequency
iscovery
5 | Animax Exit

Press « ¥ to select “Up’ or ‘Down’, then
press ENTER.

CHANNEL EDITOR
Up
Down
Insert
Swap
Rename
Disable
Preset Channel GCN
1 [ CNN News GCN
2 | AXN Sports Decode
z HBO Frequency
Discovery
5 | Animax Exit

The order of the TV channel will be changed.

Each time when you press ENTER, the item
changes as follows:

CHANNEL EDITOR

Up
Down
Insert
Swap
Rename
Disable

Preset Channel GCN

1 | AXN Sports GCN

2 | CNN News Decode

3 | HBO Frequency

4 | Discovery

5 [ Animax Exit

When completed, press « v < » to select
‘Exit’ or another option to continue, then press
ENTER.

Inserting TV Channels

Press a w to select a channel from the list,
press ENTER.

Press a v to select ‘Insert’, then press
ENTER.

CHANNEL EDITOR

Up

Down

Insert

wap
Insert to... 00 name

sable

Preset Chann,

1 [ axN spbres N
2 | CNN News Decode
‘3‘ ;BO Frequency

iscovery
5 | Animax Exit

Press « v < » or number buttons (0-9) to
enter the channel number, then press ENTER.

CHANNEL EDITOR

Up
Down
Insert
Swap
Rename
Disable

Preset Channel GCN

1 | CNN News N

2 | HBO Decode

3 | AXN Sports Frequency

4 | Discovery

5 | Animax Exit

The channel will be moved to the desired location.

When completed, press - v < » to select
‘Exit’ or another option to continue, then press
ENTER.

[ONote]

 After you insert channel(s), numbers of other
channels will change accordingly.
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Swapping TV Channels

Press a w to select a channel from the list,

then press ENTER.

Press « w to select ‘Swap’, then press

ENTER.

CHANNEL EDITOR

Up
Down

Insert

wap
name
Swap with... 0o

sable
Preset Chann L
1 | CNN o
2 | HBO Decode
3 | AXN Sports Frequency
4 | Discovery ,—l
5 | Animax Exit

Press « v < » or number buttons (0-9) to
enter the channel number, then press ENTER.

CHANNEL EDITOR

Preset Channel

GCN

1 | CNN News

Animax

AXN Sports

2

3

4 | Discovery
5 | HBO

Up
Down
Insert
Swap

Rename
Disable
GCN
Decode

Frequency

Exit

The channel will be swapped to the designated location.

To swap other TV channels, repeat steps 1-3 to
complete the settings.

Renaming TV Channels

This DVD recorder offers an on-screen input
keypad for users to complete the naming/renaming
process. Please use « v ¢ » and ENTER
buttons on your remote control to select your
desired letters, numbers or punctuation marks. For
more information about how to use the keypad,
please see the section ‘On-Screen Input Keypad’.

Press a w to select a channel from the list,
then press ENTER.

Press a ¥ to select ‘Rename’, then press
ENTER.

CHANNEL EDITOR

A B C D E F G H J K

K L M N o &P a R s T| <« |

Sovwox vz ]

o 1 2 3 4 5 6 7 8 9
Clear

Cancel ‘ ‘ Space ‘ ‘ Finish ‘

You can also press number buttons on remote control to quickly

move to the column where your desired characters are situated.

The keypad screen will be displayed.

Press a v < » to select desired characters
from the keypad, then press ENTER after each
entry.

When completed, press « v 4 » to select
‘Finish’, then press ENTER.

[ONote|

* You can enter up to 10 characters for a name.

Enabling/Disabling TV
Channels

The automatic scanning process will list all the
available channels for your reference. You can
further edit this list by activating the ‘Enable/Dis-
able’ function, which allows you to temporarily
remove unwanted channel(s) from the list or add
the previously disabled channel(s) back to the list.

Press a v to select a TV channel which
you would like to switch on/off, then press
ENTER.

Press a w to select ‘Enable’ or ‘Disable’, then
press ENTER.

CHANNEL EDITOR
Up
Down
Insert
Swap
Rename
Enable
Preset Channel GCN
1| CNN News X1 GCN
2 | Animax Decode
3 | AXN Sports
- Frequency
4 | Discovery
5 | HBO Exit

The channel selected will then be switched on or off.

To switch on or off other channels, repeat steps
1-2 to complete the settings.

23
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Setting Decoder

Use this option to switch on or off the ‘Decode’
function for particular TV channel(s).

Press a w to select a channel from the list,
then press ENTER.

Press a ¥ to select ‘Decode’, then press
ENTER.

Setting Channel Frequency

Use this option to search for better channel signal,
or to search for a particular channel which has not
been listed after the scanning process.

Press a ¥ to select a channel from the list,
then press ENTER.

Press a « to select ‘Frequency’, then press
ENTER.

The dialogue box for entering the channel
frequency will appear. Press « v 4 » or
number buttons (0-9) to enter the channel
frequency, then press ENTER.

CHANNEL EDITOR

Up

CHANNEL EDITOR

Up
Down
Insert
Swap
Rename
Disable

Preset Channel GCN

1| CNN News GCN

2 | Animax Decode

3 | AXN Sports Frequency

4 | Discovery

5 | HBO ,Tl

CHANNEL EDITOR

Up
Down
Insert
Swap
Rename
Disable

Preset Channel GCN

1 | CNN News GCN

2 | Animax el

3 | AXN Sports

4 | Discovery Frequency

5 |HBO Exit

A key icon will appear, indicating that the ‘Decode’ function

for the selected channel is switched on.

To set the ‘Decode’ function on or off for other

TV channels, repeat steps 1-2.

When completed, press « v 4 » to select
‘Exit’ or another option to continue, then press

ENTER.

Down
Insert

Swap

Rename

Preset Ch|
Frequenc TV System Scan Next
T Feoensr  TVsy

e

2lanf [@EE2]  raok 3 .
3 | AXN
5| hed Minimum: 48.2 MHz Maximum: 863.2 MHz

Press a ¥ to select a suitable TV system, then
press ENTER.

The DVD recorder will start searching for the
channel signal.

E When the scanning process is completed, press
a v to select your desired option, then press
ENTER.

If the scanning result is what you want, press
v to select ‘OK’, then press ENTER.

E If the scanning result is not what you want,
press a v to select ‘Scan Next’, then press
ENTER. The DVD recorder will then start
searching for the next available channel
frequency.

CHANNEL EDITOR

Up
Down
Insert
Swap

Rename

e

Preset Chf
Frequenc TV System
T quency ptem
2 | Aniny 0482 PALDK ¥ e
3 | axi
5 | HBdl Minimum: 48.2 MHz Maximum: 863.2 MHz

E If you decide not to make any change, press
- v to select ‘Cancel’, then press ENTER.

To apply the frequency setting to other chan-
nels, repeat steps 1-5.




When completed, press « v < » to select
‘Exit’ or another option to continue, then press
ENTER.

[ONote|

* If you have not completed the channel scanning
process before you select this option, a dialogue
box asking you to do so will appear. Press < »
to select desired application, then press ENTER.
If you still choose not to scan channels, you will
need to switch on the channels one by one for
further applications.

25
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se t t'-ng t he s howv,- ew@ E ;l"f)s.set GCN for other channels, repeat steps
system When completed, press « v < » to select

‘Exit’, then press ENTER.

The ShowView® system is a specially-designed
feature for recording TV programs. The system
greatly simplifies the timer recording process, as

it does not require users to enter program informa-
tion, such as date, channel number and start/end
time, which are all contained in ShowView®
numbers. You can complete the timer recording
setup simply by inputting the ShowView® number,
which can be found in most newspapers, TV listing
magazines or online sources.

Setting up ShowView®
System

As channel numbers may vary depending on where
you live, it is suggested that you build up a match-
ing channel list when you first set up the DVD
recorder. This step will help you to make use of
the ShowView® system for future timer recording
settings.

Press TV/MODE or press SOURCE to set
“TV’ as the signal source.

By default, pressing TV/IMODE allows you to switch to TV
directly. However, if you have activated the ‘SCART Bypass
mode earlier through Setup menu, you can only press
SOURCE to switch to TV.

>

If you press SOURCE, you may need to press the button
more than once to switch to ‘TV".

Press EDIT to display the Channel Editor

menu.
Press a v to select a TV channel, then press
ENTER.
Press a v < » to select ‘GCN’, then press
ENTER.
CHANNEL EDITOR

Up
Down

Insert

wap

Preset Channel GCN

[:> name
Preset Chann| a 01

1 | CNN
Animax Decode

AXN Sports
— Frequency
Discovery

HBO Exit

sable

ol

w|n

IS

o)

The dialogue box for entering GCN will appear.

Press « v < » or number buttons (0-9) to
enter the GCN (guide channel number), which
is the channel number used by the Show View®
system, then press ENTER.
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Easier

ApA)Iication

his chapter introduces three specially—

designed interfaces, which aim to offer
you a more convenient and hassle—free
operation environment. Please follow the
steps listed below for the applications.

Contents MenU........coooiiiiiiiiiiiie, 27
* Introducing Contents Menu................. 28
* Using Contents Menu........................ 29
On-Screen Input Keypad...................... 30
¢ Introducing On=Screen Input Keypad.....31
» Using On-Screen Input Keypad............ 31
Easy GUIder......coviviiiiiiie e 32
* Introducing Easy Guider...................... 33
* Using Easy Guider: Play....................... 33
* Using Easy Guider: Record................... 35
» Using Easy Guider: Timer Record.......... 36
» Using Easy Guider: Copy........cooeoevinnnn. 39
* Using Easy Guider: Disc Tools.............. 41

Contents Menu

Contents Menu offers you a quick overview of
what stored in your selected medium by displaying
files according to file types. This easy-to-follow
interface can be directly activated by pressing the
CONTENTS button on your remote control.

Before you start...

Check whether the video signal of this DVD
« recorder is correctly displayed on your TV
screen.

Connecting up Your DVD Recorder (p.12)

Check whether the remote control works. Are
« the batteries being installed?

27

§5200) 2 uonyva1ddy 421Sv5] y N



Introducing Contents P Y

Menu — (%)

— ii B1.mp3

O‘; A2.mp3

Overview of Contents
Men u —— ;; B2.mp3

c & ]| ctirg
Press CONTENTS to display the Contents e

Menu

Press « v <« » and ENTER to select and e D1.ipg
confirm specific application.

C2.jpg

... these files will be regrouped and displayed as follows

wm@ B Music@ R P\cture® (@ D\/D(:) in the Contents Menu without changing the original data

@ ) structure.

001

TITLE 01 TITLE 02 TITLE 03 ! A &} Almp3

07:32PM 12:04/05 07:32PM 02/14/15 05:45PM 03/06/05 i .

00h00MOSs SP 00h06m18s HQ ~ O0RGOMOSs SP | Music
mm

)
! 1
i '
! 1

i
| :
! 1
TITLE 04 TITLE 05 TITLE 06 ! Default &3 B1.mp3
12:16AM 01/01/03  12:16AM 01/01/03  13:19AM 01/01/03 ! !
Q0h00m09s_SP  00hDOmA4Is SP  00hOOmMS57s SP o ‘n; ]
8)] 002({Q) ® i |
‘ |
. ]
)
'
)

Text View Exit i: 2) ledl

! c
! Picture
— (2] B
1. Indicates the source medium. Press to select the : |8 ]| czirs !
source medium you wish to view. Default
* = | Q|| D1.jpg i
2. Indicates a file catalogue containing video files. : :
Press to view all video files in the selected ~ TTTTTTTTTTTTTTIIITTTTTOOOT
medium.
. . . 7. Indicates the page number.
3. Indicates a file catalogue containing music files/
albums. Press to view all music files/albums in 8. Indicates the ‘Previous Page’ function. Press to
the selected medium. go to the previous page. Alternatively, you can
4. Indicates a file catalogue containing picture press M4« button on your remote control.
ﬁles/albums. Press to view all picture files/al- 9. Indicates the “Next Page’ function. Press to
bums in the selected medium. switch to the next page. Alternatively, you can
5/6. Indicates a title/file/album in the file catalogue. press MM button on your remote control.
Press » PLAY to start playback. 10. Indicates the page number index.

With the exception of the video file catalogue, a ‘Default

Album’ will be automatically created in both music and 11. Indicates the list display format. Press to switch

picture catalogues to accommodate media files which are not between ‘Thumbnail View’ (displayed in im-
grouped under particular directories in the source medium. age/icon) and ‘Text View’ (displayed in text).
For example, if you organize your music and picture files as

Sollows... 12. Indicates the ‘Exit’ function. Press to exit the

Contents Menu.

| (Note.

* Please allow a few seconds for the DVD recorder
to display all your files in the Contents Menu.

¢ Only files in media formats will be displayed in
the Contents Menu. Normal data files will not be
shown.
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Inside the Catalogues Using Contents Menu

In the individual file catalogue, each title/file or file
album is also presented with detailed data informa-

tion.
A. Inside the Video File Catalogue VieW|ng Files on Disc
Video Hjﬂ Music Hf"‘[ Picture
o Press 2 OPEN/CLOSE to open the disc tray.
Place the disc on the tray.
ZNTLE 01 (> 1i1ie 02 TITLE Press 2 OPEN/CLOSE to close the tray.
07:32PM 12:04/05 07:32PM 02/14/15 05:4¢
(B)0h00m0Ss S{g) 00h06m18s HQ ~ 0OhO )
— Press CONTENTS to display the Contents
Menu.
L Press « v < » toselect ‘DVD’ as the source
1. Indicates a video file or DVD title. medium, then press ENTER.
2. Indicates the file or title name.
[ Picture ] (@ DVD &
3. Indicates the file format.
& HpD
4. Indicates the recording mode. DVD
5. Indicates the length of file.
[ (Note |

« If the file or title name is too long, it will be
abbreviated. Press 4 » to select the type of files (Video/

. Music/Picture) you wish to view.
* The file or title name may not be correctly )y

displayed, if it contains characters which use a
coding page or certain character sets not sup-
ported by this DVD recorder. However, this will
not affect functions you wish to apply. You can
still play back or copy these files without any

[&] video | (3] Music | Picwre 1C

problem. E Press ENTER or v to enter the selected
catalogue.
B. Inside the Music or Picture File Catalogue s e e [ @b =
[
I_[ Video |[53] Music |[W¥/] Picture oot

h TITLE 01 TITLE 02 TITLE 03
07:32PM 12:04/05 07:32PM 02/14/15 05:45PM 03/06/05
@ 00h00MO5s SP | 00h06m18s HQ ~ 00hOOMOSs SP

J

(@efautt b | @si5_100 051

107 Files 05/3@07 Files 05,

[ )

1. Indicates a file album. Press ENTER to go into
the album, or press » PLAY to start playback.

[

[—

TITLE 04 TITLE 05 TITLE 06
12:16AM 01/01/03 12:16AM 01/01/03 13:19AM 01/01/03
00h00M09s SP  00h00m41s SP  00hOOM57s SP

ootfooa I T T
e | Text View I Exit [o»l

If you want to go to a different page, use the W4, W or page
number button to make selection.

—

If you have selected the video file catalogue,
press « ¥ 4 » to select desired title or file,

2. Indicates the album name. then press ENTER to start playback.

3. Indicates the number of files contained in the

album. E If you have selected the music or picture file

catalogue, press - v 4 » to select desired
album. Press » PLAY to start playback, or
press ENTER to go to the selected album.

4. Indicates a default album, which groups together
files which are not included in any specific
folder in the source medium.
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E Press a v € » to select desired track or file,
then press ENTER to start playback.

Viewing Files on Hard
Drive

Press CONTENTS to display the Contents
Menu.

Press a v € » to select ‘HDD’ as the source
medium, then press ENTER.

][] Picture | (®DVD &
[S| HDD
DVD

Press 4 » to select the type of files (Video/
(Music/Picture) you wish to view.

Press ENTER or ¥ to enter the selected
catalogue.

If you have selected the video file catalogue,
press « v 4 » to select desired title or file,
then press ENTER to start playback.

E If you have selected the music or picture file
catalogue, press « v < » to select desired
album. Press » PLAY to start playback, or
press ENTER to go to the selected album.

Press a v < » to select desired track or file,
then press ENTER to start playback.

On-Screen Input
Keypad

On-screen input keypad offers you a simple way to
enter file names. Entering your desired characters
can be easily done by pressing the « v ¢ » and
ENTER buttons on your remote control.

Before you start...

Check whether the video signal of this DVD
« recorder is correctly displayed on your TV
screen.

[/ Connecting up Your DVD Recorder (p.12)

Check whether the remote control works. Are
« the batteries being installed?
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Introducing On-Screen
Input Keypad

0]

- < - ®
N S 2 oo

A
K
U
0 4 5 6 7 8 9

@Cnntel \@ Space \@Finisn |

You can also press number buttons on remote control to quickly
move to the column where your desired characters are situated

1. Indicates the area for entering names.
2. Indicates the available characters or symbols.

3. Indicates the available input options. Press to
switch among uppercase letters [A], lowercase
letters [a], symbols [Symbol] and accented
letters [International].

You can use the corresponding shortcuts on remote control
to quickly select desired characters. When you press one of
the number buttons, available characters will be highlighted
on-screen. Press the button repeatedly until you desired
character is highlighted, then press ENTER to confirm your
selection.

4. Indicates the backward direction button. Press to
move the cursor backwards on the entry bar.

5. Indicates the forward direction button. Press to
move the cursor forwards on the entry bar.

6. Indicates the function of deleting characters one
by one in a backward direction.

7. Indicates the function of deleting all characters
shown on the entry bar.

8. Indicates the function of discarding changes and
returning to the previous page.

9. Indicates the function of inserting space.

10. Indicates the function of quitting the applica-
tion.

Using On-Screen Input
Keypad

Naming a New Title or File

When the keypad screen is displayed, press
a v 4 » to select the input option button,
then press ENTER. Press ENTER repeatedly
to select your desired input option.

6 7 8 9 Back

e

Clear

PRSUUEE E

Press a v <« » to select desired characters,
then press ENTER.

You can enter up to 30 characters for a title name.

If you want to make changes during the pro-
cess, press « v 4 b to select ‘Back’, which
allows you to delete character by character in a
backward direction, then press ENTER.

If you want to delete all the characters you
have entered, press « v < » to select ‘Clear’,
then press ENTER.

6 7 8 9 Back

G

Clear

PSS e B

When completed, press « v 4 » to select
‘Finish’, then press ENTER.

| (}Note.

* The entry bar CANNOT be left blank. If such
a condition occurs, you will not be able to exit
the keypad screen. Please follow the instruction
given in the pop-up dialogue box, and go back to
complete the process.
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Renaming a Title or File

When the keypad screen is displayed, the
‘Clear’ button will be automatically high-
lighted. Press ENTER to clear the entry bar, or
press - v to select ‘Back’; and delete the old
name character by character.

Press - v < » to select the input option
button, then press ENTER. Press ENTER
repeatedly to select your desired input option.

Press a v < » to select desired characters,
then press ENTER.

You can enter up to 30 characters for a title name.

If you want to make changes during the pro-
cess, press - v 4 » to select ‘Back’, which
allows you to delete character by character in a
backward direction, then press ENTER.

If you want to delete all the characters you
have entered, press « v 4 » to select ‘Clear’,
then press ENTER.

When completed, press « v < » to select
‘Finish’, then press ENTER.

Easy Guider

Easy Guider is an on-screen user interface,
designed to help you quickly operate the major
functions offered by this DVD recorder. All func-
tions in Easy Guider can be conveniently selected
and activated by pressing « v ¢ » and ENTER
buttons on your remote control.

Before you start...

Check whether the video signal of this DVD
« recorder is correctly displayed on your TV
screen.

7‘:51[; Connecting up Your DVD Recorder (p.12)

Check whether the remote control works. Are
« the batteries being installed?
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Introducing Easy Guider

Press GUIDER to display the Easy Guider menu.

EAsY GUIDER

0]
dj Record

1. Indicates the function shortcuts offered by Easy
Guider.

2. Indicates the function selected. Press to confirm
selection.

3. Indicates the function of exiting current pro-
gram. This section also features a PIP (picture in
picture) interface, which allows you to continue
monitoring image shown on your TV.

If you have been watching TV...
Image from your selected channel will be

shown.

If you have been watching DVD-Video or
VCD...
Image of the disc being played will be shown.

If you have been listening to an audio CD...
The display window will be blank.

If you have been browsing pictures...
A ‘Picture’icon will be shown.

| (}Note

* Press GUIDER, if you would like to exit the
Easy Guider menu.

Using Easy Guider: Play

Before you start...

Check whether your source medium contains
« displayable media files.

Playing Video Files

On the Easy Guider menu, press - v to select
‘Play’, then press ENTER.

EASY GUIDER

©)
\1:> Play

D Record

Timer Record
Co

I:‘ Disc Tools

Press a v toselect ‘DVD’ or ‘HDD?’ as the
source medium, then press ENTER.

EAsY GUIDER

@ DvD
D HDD

Exit

Press a ¥ to select ‘Video’, then press
ENTER.

EAsY GUIDER

Exit

E' Pictures with Music

Press « v 4 » to select a title (program) you
wish to play, then press ENTER.

Playback will then start.
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E Press I PAUSE/STEP to pause playback.
Press » PLAY to resume normal playback.
Press B STOP to stop playback at a marked
stop.

Press B STOP again to bring the playback to
a full stop.

[ONote]

* When you insert a DVD-Video disc, VCD or
SVCD, playback will begin automatically.

Playing Music Files

On the Easy Guider menu, press « ¥ to select
‘Play’, then press ENTER.

Press a v to select ‘DVD’ or ‘HDD’ as the
source medium, then press ENTER.

Press a ¥ to select “Music’, then press
ENTER.

Press « v < » to select a file album you wish
to play, then press ENTER.

Press « v < » to select a file or track, then
press ENTER or » PLAY to start playback.

E Press I» PAUSE/STEP to pause playback.
Press » PLAY to resume normal playback.
Press B STOP to stop playback at a marked
stop.

Press B STOP again to bring the playback to
a full stop.

* When you insert an audio CD, playback will
begin automatically.

* If an MP3 file name includes two-byte character,
it may not be displayed correctly.

* This DVD recorder does not support ID3 (for
MP3) and WMA tags.

e This DVD recorder does not support MP3-Pro
files.

* The MP3 file bitrates supported by this DVD
recorder are: 32Kbps - 320Kbps.

Playing Picture Files

On the Easy Guider menu, press « v to select
‘Play’, then press ENTER.

Press a v to select ‘DVD’ or ‘HDD’ as the
source medium, then press ENTER.

Press a ¥ to select ‘Picture’, then press
ENTER.

Press a« v < » to select a file album you wish
to play, then press ENTER.

Press a v < » to select a file, then press
ENTER or » PLAY to start playback.

E Press a to rotate the picture clockwise, or
press v to rotate it counterclockwise.
Press 4 or » to skip the picture.

Press I» PAUSE/STEP to pause playback.
Press » PLAY to resume normal playback.
Press B STOP to stop playback.

Playing Picture with Music

On the Easy Guider menu, press « v to select
‘Play’, then press ENTER.

Press « ¥ to select ‘DVD’ or ‘HDD’ as the
source medium, then press ENTER.

Press a w to select ‘Picture with Music’, then
press ENTER.

Press - v < » to select a picture album, then
press ENTER.

Press a v < » to select a file, then press
ENTER to start playback.

E The music file catalogue will then be
displayed. Press « v 4 » to select a music
album, then press ENTER.

Press a v € » to select a file or track, then
press ENTER to start playback.

E Press a to rotate the picture clockwise, or
press ¥ to rotate it counterclockwise.
Press 4 or » to skip picture.

Press M4 or M to skip music file.

E Press I PAUSE/STEP to pause playback.
Press » PLAY to resume normal playback.
Press B STOP to stop playback.

Playing Last Recorded
Title (On Hard Drive Only)

On the Easy Guider menu, press « ¥ to select
‘Play’, then press ENTER.

Press a v to select ‘HDD?’ as the source
medium, then press ENTER.
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Press a w to select ‘Last Recorded’, then
press ENTER.

Playback of the last recorded title will then
start.

Press I» PAUSE/STEP to pause playback.
Press » PLAY to resume normal playback.
Press B STOP to stop playback at a marked
stop.

Press B STOP again to bring the playback to
a full stop.

Using Easy Guider: Record

Before you start...
Check whether you select and insert a record-
« able disc.
(%, Guide to Using the Discs (p.93)

Check whether there is enough space on the
o disc or on the hard drive.

Check whether the channel scanning process

« for your TV is completed.
1, Setting TV Channels (p.19)

.“1 Important

* If you use blank DVD-RW discs, you will need
to format the discs before recording. Press a v to
select ‘Quick Preparation’ or ‘Full Preparation’,
then press ENTER.

Please select method for preparing disc

"’Q Full Preparation(30~60 minutes)
@ Prepare disc for play in other DVD players

Quick Preparation
Disc requires finalization after recording

* If you use blank CD-R/RW discs, you will
need to format the discs before recording. Press
a v < » to select a suitable format, then press
ENTER.

Please select recording format.

(04

Audio CD

Audio Recording
One Disc = ~70 minutes

Video Recording (Better Quality)
One Disc (SVCD) = ~34 minutes

Video Recording (Normal Quality)
One Disc (VCD) = ~68 minutes

Data Recording
One Disc = ~700 MB

Caution: You may NOT change CD formats once the original layout is created.

On the Easy Guider menu, press « v to select
‘Record’, then press ENTER.

EAsY GUIDER

[ ]
Record

v
= | Timer Record
D Disc Tools

Press « ¥ to select the signal source on which
the program you would like to record is being
broadcast or played, then press ENTER.

EAsY GUIDER

v
D Front AV
SCART
|:| DV

Exit

If you select “TV’, press a w to select
the channel you want to record, then press
ENTER.

Press a wto select ‘DVD’ or ‘HDD’ as the
target medium, where you would like to save
the recording, then press ENTER.

The recorder will automatically detect the
disc you have inserted, and suggest a suitable
format for recording. If the suggested format is
not what you wish to use, press « ¥ to select
‘Other Formats’, then press ENTER.
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EAsSY GUIDER

DVD VR

Other Formats

Exit

If you choose to save the recording on a DVD
disc or on hard drive, press « ¥ to select a
recording mode, then press ENTER.

E Recording will then start.

Press ® STOP to stop recording.
Press I® PAUSE/STEP to pause recording.
Press P PAUSE/STEP again to resume
recording.

Using Easy Guider: Timer
Record

Before you start...

Check whether you select and insert a record-
« able disc.

%, Guide to Using the Discs (p.93)

Check whether the system date and time of
« the DVD recorder is correct.

1t Setting System Time (p.17)

Check whether there is enough space on the
o disc or on the hard drive.

Check whether the channel scanning process
« for your TV is completed.

Setting TV Channels (p.19)
.“1 Important

* If you use blank DVD-RW discs, you will need
to format the discs before recording. Press a v to
select ‘Quick Preparation’ or ‘Full Preparation’,
then press ENTER.

Please select method for preparing disc

"Q Full Preparation(30~60 minutes)
@ Prepare disc for play in other DVD players

Quick Preparation
Disc requires finalization after recording

* If you use blank CD-R/RW discs, you will
need to format the discs before recording. Press
a v ¢ ) to select a suitable format, then press
ENTER.

Please select recording format.

©r

Audio CD

Audio Recording
One Disc = ~70 minutes

Video Recording (Better Quality)
One Disc (SVCD) = ~34 minutes

Video Recording (Normal Quality)
One Disc (VCD) = ~68 minutes

Data Recording
One Disc = ~700 MB

Caution: You may NOT change CD formats once the original layout is created.

Normal Timer Recording

On the Easy Guider Menu, press a v to select
‘Timer Record’, then press ENTER.

EAsY GUIDER

(o]
|:| Record

o
Py Exit

Disc Tools

Press a v to select ‘Date/Time Setting’, then
press ENTER.

EASY GUIDER

Date/Time Setting

o= .
ShowView Setting

Exit

Press a w to select the signal source on which
the program you would like to record is being
broadcast or played, then press ENTER.
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If you select “TV’, press a ¥ to select
the channel you want to record, then press
ENTER.

Press a w to switch on or off the PDC func-
tion, then press ENTER.

Press a + to select ‘Once’, ‘Daily’ or

‘Weekly”’.

Recording | Suitable Applications

Frequency

Once To record program broadcast during
specific time slot.

Daily To record program broadcast every day
during specific time slot.

Weekly To record program broadcast on certain
day(s) every week during specific time
slot.

E Press « v 4 » or number buttons (0-9) to
enter the date, then press ENTER.

Press a v < » or number buttons (0-9) to
enter the time, then press ENTER.

E Press a v toselect ‘DVD’ or ‘HDD?’ as the
target medium, then press ENTER.

E Press a w to select the suitable format, if you
use a DVD disc, then press ENTER.

EAsY GUIDER

o) | DVD VR

Other Formats

Exit

Press a w to select a recording mode, then
press ENTER.

If your signal source is set to “TV’, press
- v to set ‘Sound’ options, then press EN-
TER.

The Timer Program information will appear.
Press ENTER to exit the screen.

EASY GUIDER

Setting Saved
Repeat Once (MON)
Source v 2

Date 12/05/2005

Time 06:58AM~07:58AM
HDD/DVD  HDD

Mode SP

PDC Turn Off

Sound Stereo Exit

& About ‘VPS/PDC’

VPS (video programming system)/ PDC (program
delivery control) are used to control the activation
and duration of preset TV channel recordings. If

a TV program starts earlier than is scheduled, the
DVD recorder will then be automatically switched
on and off according to the updated time.

| (INote.

» This DVD recorder allows you to set up a maxi-
mum of 32 Timer Programs. If your setting list
is full, you need to delete some of the programs
before you can input new ones.

* This DVD recorder allows you to use a maximum

of 20 PDC settings for your preset Timer Pro-
grams. If you have used up the quota, you need
to cancel the setting on some preset programs
before you can assign the feature to other timer
recordings. Meanwhile, please be reminded that
the PDC is applicable only when your DVD
recorder is in standby mode. If you have been
using the DVD recorder before a preset Timer
Program starts, it will not be monitored by the
PDC system, and the preset Timer Program will
begin following the original schedule.

» This DVD recorder allows users to enter date up

to 31/12/2099 (December 31, 2099). Date beyond

this day CANNOT be set.

% Setting System Date (p.16)

* This DVD recorder features ‘power-on’ timer
recording: you do not need to switch off the
recorder to activate the function.

Timer Recording through
ShowView® System

On the Easy Guider Menu, press « v to select

‘Timer Record’, then press ENTER.

Press a v to select “ShowView Setting’, then
press ENTER.

EASY GUIDER

<

Date/Time Setting
=)

ShowView Setting

Exit
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Press a ¥ to select ‘Once’, ‘Daily’ or
‘Weekly’.

Press number buttons (0-9) to enter the
ShowView " number, then press ENTER.

EAsY GUIDER

Show View #

12345+

Exit

The ‘Preset Channel’ dialogue box will then
appear, if the DVD recorder fails to find
information of a corresponding channel. Press
- v to enter the channel number shown on
your TV, then press ENTER.

EAsY GUIDER

GCN

002

A%

Preset Channel

Exit

| (Note.

+ To make use of ShowView® system for timer
recording, you need to match the GCNs (guide
channel numbers) used by the Show View®
system with the channel numbers shown on
your TV, so that the relevant information can be
correctly assigned to the programs you would
like to record.

E Press a w to switch on or off the PDC func-
tion, then press ENTER.

Press « ¥ to select ‘DVD’ or ‘HDD’ as the
target medium, then press ENTER.

E Press « ¥ to select the suitable format, if you
use a DVD disc, then press ENTER.

E Press a ¥ to select a recording mode, then
press ENTER.

If your signal source is set to ‘TV’,
press a w to set ‘Sound’ options, then press
ENTER.

The Timer Program information will appear.
Press ENTER to exit the screen.

# About ‘VPS/PDC’

VPS (video programming system)/ PDC (program
delivery control) are used to control the activation
and duration of preset TV channel recordings. If

a TV program starts earlier than is scheduled, the
DVD recorder will then be automatically switched
on and off according to the updated time.

| (Note.

* This DVD recorder allows you to set up a maxi-
mum of 32 Timer Programs. If your setting list
is full, you need to delete some of the programs
before you can input new ones.

* This DVD recorder allows you to use a maximum
of 20 PDC settings for your preset Timer Pro-
grams. If you have used up the quota, you need
to cancel the setting on some preset programs
before you can assign the feature to other timer
recordings. Meanwhile, please be reminded that
the PDC is applicable only when your DVD
recorder is in standby mode. If you have been
using the DVD recorder before a preset Timer
Program starts, it will not be monitored by the
PDC system, and the preset Timer Program will
begin following the original schedule.

* This DVD recorder features ‘power-on’ timer
recording: you do not need to switch off the
recorder to activate the function.

Using Easy Guider: Copy

.‘g Important

* You may only use this DVD recorder to repro-
duce or copy materials for which you own the
copyright; or have obtained permission to copy
from the copyright owner; or you otherwise have
a legal right to reproduce or copy. Unless you
own the copyright; or have obtained permission
from the copyright owner; or otherwise have
a legal right to reproduce or copy, you may be
violating the law, including copyright law, and
may be subject to payment of damages and other
remedies.

 This DVD recorder complies with ISO standard
for discs; therefore, it may not be able to let
you copy every file to discs if the number of file
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directory level is more than seven in your source
medium. Nevertheless, all your files can still be
previewed through Contents Menu.

Before you start...

Check whether you select and insert a record-
« able disc.

‘. Guide to Using the Discs (p.93)

Check whether there is enough space on the
« disc or on the hard drive.

Check whether there are files on the disc you
« insert, if you would like to make copies from
disc to the hard drive.

Copying from Disc to Hard
Drive

On the Easy Guider Menu, press a v to select
‘Copy’, then press ENTER.

EAsY GUIDER

]

Exit

D Disc Tools

Press « ¥ to select ‘DVD to HDD’, then press
ENTER.

EAsY GUIDER

DVD to HDD

HDD to DVD

Exit

If you have inserted an audio CD, VCD or
SVCD, press 4 » to select ‘Go’, then press
ENTER.

The copying process will then start.

If you have inserted a disc which contains
video titles only, a disc menu will appear. Press
a v < »toselect the title you would like to
copy, then press ENTER.

The copying process will then start.

If you have inserted a data disc which contains
both data and media files, press « v < » to
select the type of file you would like to copy,
then press ENTER.

EASY GUIDER

Video
Music
I:' Picture

Exit
IR

E If you have chosen to copy all files, the copy-
ing process will then start.

If you have chosen to copy video files, press
a v <« »toselect desired file, then press
ENTER. The copying process will then start.

E If you have chosen to copy music or picture
files, press « v 4 » to select desired album,
then press ENTER.

E Press a v < » to select desired file, then press
ENTER. A dialogue box showing further
copying options will appear.

EAsY GUIDER

Would you like to copy the selected file or the whole
album?

Selected File Whole Album

Press 4 » to select ‘Selected File’, then press
ENTER, if you would like to copy only the
selected file.

Press ¢ » to select “Whole Album’, then press
ENTER, if you would like to copy all files in
the album.

 The dialogue box will appear when you first enter
the album. If you decide to copy the whole album
after adopting the ‘Selected File” option, you will
need to exit the album first. Press « v < » to
select ‘Return’, then press ENTER to go back to
the album level.

When completed, press « v 4 » to select
‘Exit’, then press ENTER to exit the Contents
Menu.
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Press a v < » to select ‘Exit’, then press
ENTER or press GUIDER to exit the Easy
Guider.

» Materials recorded on a VCD/SVCD disc
cannot be copied to the hard drive before the
disc is finalized.

 The title on the DVD-Video disc cannot be
copied from DVD to hard drive.

Copying from Hard Drive
to Disc

On the Easy Guider Menu, press « v to select
‘Copy’, then press ENTER.

EAsSY GUIDER

Exit

D Disc Tools

Press a ¥ to select ‘HDD to DVD?’, then press
ENTER.

EASY GUIDER
(@)
DVD to HDD

- HDD to DVD

Exit

If you have inserted an audio CD, VCD or
SVCD, press 4 » to select ‘Go’, then press
ENTER.

The copying process will then start.

If you have inserted a disc which contains
video titles only, a disc menu will appear. Press
a v < ) to select the title you would like to
copy, then press ENTER.

The copying process will then start.

If you have inserted a data disc which contains
both data and media files, press « v 4 » to
select the type of file you would like to copy,
then press ENTER.

EASY GUIDER

Video
77| Music
I:' Picture Exit

E If you have chosen to copy video files, press
a v < »toselect desired file, then press
ENTER. The copying process will then start.

If you have chosen to copy music or picture
files, press « v < » to select desired album,
then press ENTER.

Press a v € » to select desired file, then press
ENTER. A dialogue box showing further
copying options will appear.

EAsY GUIDER

Would you like to copy the selected file or the whole
album?

Selected File Whole Album

Press ¢ » to select ‘Selected File’, then press
ENTER, if you would like to copy only the
selected file.

Press 4 » to select “Whole Album’, then press
ENTER, if you would like to copy all files in
the album.

| (Note

* The dialogue box will appear when you first enter
the album. If you decide to copy the whole album
after adopting the ‘Selected File’ option, you will
need to exit the album first. Press « v < » to
select ‘Return’, then press ENTER to go back to
the album level.

E Press a v < » to select other files you would
like to copy, then press ENTER.

When completed, press - v € » to select
‘Exit’, then press ENTER to exit the Contents
Menu.

Press « v 4 » to select “Exit’, then press
ENTER or press GUIDER to exit the Easy
Guider.

I Note |

* Video files with ‘DVD-Video’ in file names
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can only be copied to an emptied or new
DVD disc (DVD-R/RW and DVD+R/RW).

* Video files with “VCD’ in file names can
only be copied to a CD disc (CD-R/RW)
prepared in ‘VCD’ format.

* Video files with ‘SVCD’ in file names can
only be copied to a CD disc (CD-R/RW)
prepared in ‘SVCD’ format.

* CD-R/RW discs prepared in ‘Audio CD’
format can only be used to copy WAV music
files. When the copying is completed, you
need to finalize the disc first before playing it
on other compatible devices.

If you copy recorded titles to a blank DVD
disc (DVD-R/RW, DVD+R/RW), you will
not be able to use the same disc to copy data
files, and vice versa.

Using Easy Guider: Disc
Tools

Disc Tools offers a quick access to completing
post-production tasks. With Disc Tools, you can
easily erase materials on discs and finalize discs
when necessary.

Tools for Hard Drive: Erase

Before you start...

] If you would like to use the ‘Erase’ function,
« please make sure all your important files
are safely backed up. Once the function is

executed, all contents will be permanently
deleted.

On the Easy Guider menu, press « v to select
‘Disc Tools’, then press ENTER.

EASY GUIDER

]

Record

@ v
e, Timer Record
A=

Exit

Press a w to select ‘Tools for Hard Drive’,
then press ENTER.

Press a « to select ‘Erase’, then press
ENTER.

EAsY GUIDER

@ Erase

|
@li Clean up
I:‘ Defragment Exit

Press 4 » toselect ‘Go’, then press ENTER
to start erasing.

EAsY GUIDER

&

Gol! Exit
Caution: All contents
will be erased

The erasing process will then start.

E When completed, press « v < » to select
‘Exit’, then press ENTER.

Tools for Hard Drive: Clean
up

On the Easy Guider menu, press « v to select
‘Disc Tools’, then press ENTER.

41

§5200) 2 uonyvo1ddy 421505 y N



EASY GUIDER

(o]
|:| Record
Timer Record

[«

\@J( Disc Tools

Press a w to select ‘Tools for Hard Drive’,
then press ENTER.

Press a « to select ‘Clean up’, then press
ENTER.

EAsY GUIDER

Erase
=
/| Cleanu
p
D Defragment Exit

Press a « to select ‘Delete Older Files’,
‘Delete Larger Files’, ‘Delete Seldom Played
Files’, ‘Delete Album’, or ‘Delete All’, then
press ENTER.

EAsY GUIDER

Delete Older Files
(| Delete Larger Files

», | Delete Seldom Played
L= | Files

@ Delete Album

<% | Delete All

Exit

If you choose to delete files or albums, press
< » to select ‘Delete’ or ‘Skip’, then press
ENTER.

EASY GUIDER

S 70 e8

Name canaletto14

Date 2000/01/12

Dimension 900x542

Format JPEG

Size 128 KB Exit
Delete Skip

E If you choose to delete all files, press 4 » to
select ‘Go’, then press ENTER.

EASY GUIDER

Go!! Exit

The clean-up process will then start.

E When completed, press « v 4 » to select
‘Exit’, then press ENTER.

| (Note.

* The application will permanently delete selected
files or albums.

* Overall clean-up time may vary depending on the
original recording conditions.

Tools for Hard Drive:
Defragment

On the Easy Guider menu, press « v to select
‘Disc Tools’, then press ENTER.

EASY GUIDER

Record
Timer Record

Exit

(o] Disc Tools
7

Press a w to select ‘Tools for Hard Drive’,
then press ENTER.

Press a ¥ to select ‘Defragment’, then press
ENTER.

EASY GUIDER

Erase
—7{ Clean up

@ Defragment Exit

Press 4 » to select ‘Go’, then press ENTER
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to start defragmenting hard drive.

EASY GUIDER

Oo

2

Go!! Exit

The defragmenting process will then start.

E When completed, press « v 4 » to select
‘Exit’, then press ENTER.

| (}Note.

» Materials on the hard drive will not be lost during
this process.

* Regular defragmenting is recommended, as it
helps improve overall performance of the hard
drive.

¢ If during the process you decide to cancel the
application, you can press 4 » to select ‘Exit’,
then press ENTER to exit the present screen.

Tools for Disc: Erase

On the Easy Guider menu, press « v to select
‘Disc Tools’, then press ENTER.

EAsY GUIDER

Play

Exit

(\@J Disc Tools

Press a w to select ‘Tools for Disc’, then
press ENTER.

Press a v to select ‘Erase’, then press
ENTER.

EASY GUIDER

Erase
@ Finalize (Make
@) | compatible

Label Disc Exit

Press 4 » toselect ‘Go’, then press ENTER
to start erasing.

EAsY GUIDER

X3

Gol! Exit
Caution: All contents
will be erased

The erasing process will then start.

E When completed, press « v < » to select
‘Exit’, then press ENTER.

Tools for Disc: Finalize
(Make Compatible)

On the Easy Guider menu, press « ¥ to select
‘Disc Tools’, then press ENTER.

Press a w to select “Tools for Disc’, then
press ENTER.

Press a v to select ‘Finalize (Make Compat-
ible)’, then press ENTER.

Press 4 » to select ‘Go’, then press ENTER
to start finalizing.

The finalizing process will then start.

E When completed, press « v < » to select
‘Exit’, then press ENTER.

P About ‘Finalization’

Finalizing a disc is a necessary step when you want
to share certain types of digital content with others.
Once a disc is finalized, it can be played back on
other DVD players or on PCs.
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Recording
. Content .
Disc Tvpe Finalization after
P Finalization
Data file Not required N/A
DVD-R
DVD+VR | Required No
Data file Not required N/A
Full
Not
Prepara- . N/A
. Required
DVD-RW tion
DVD+VR
Quick
Prepara- Required | Yes
tion
Data file Not required N/A
DVD+R
DVD+VR | Required No
Data file Not required N/A
DVD+RW
DVD+VR | Not required N/A

* Only discs used to record video titles require
finalization. Discs containing other types of
media files are considered as data: there is no
need to finalize these discs.

Tools for Disc: Label Disc

On the Easy Guider Menu, press « v to select
‘Disc Tools’, then press ENTER.

Press a w to select ‘Tools for Disc’, then
press ENTER.

Press a ¥ to select ‘Label Disc’, then press
ENTER.

The on-screen keypad will then be displayed.

Press « v ¢ » and ENTER buttons to enter
the name.

‘?‘l‘; On-Screen Input Keypad (p.28)
E After finishing entering the characters, press

a v < »toselect ‘Finish’, then press ENTER
to start labeling the disc.

When completed, press « v 4 » to select
‘Exit’, then press ENTER.
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Recording

his chapter introduces the recording

function offered by this DVD recorder.
Please follow the steps listed below for the
application.

* Recording from TV.....oooovviiiiiiinin.. 46
» Recording from VCR/V8 Camcorder...... 47
= Recording from DV (Digital Camcorder)..48

* One—Touch Recording................cn.... 49
- Adding New Recording Session(s)........ 49
* Playing Last Recorded Title.................. 49
* Using Chapter MarK...................o.ooae. 50

Recording

Make use of the recording feature to preserve your
favorite TV programs and to transfer your home
videos to DVD discs.

.‘g Important

* If you use blank DVD-RW discs, you will need
to format the discs before recording. Press « « to
select ‘Quick Preparation’ or ‘Full Preparation’,
then press ENTER.

Please select method for preparing disc

Quick Preparation
@ 4 Disc requires finalization after recording

,‘/‘ Full Preparation(30~60 minutes)
@ Prepare disc for play in other DVD players

* If you use blank CD-R/RW discs, you will
need to format the discs before recording. Press
a ¥ < » toselect a suitable format, then press
ENTER.

Please select recording format.

©'

Audio CD

Audio Recording
One Disc = ~70 minutes

Video Recording (Better Quality)
One Disc (SVCD) = ~34 minutes

Oy

Video Recording (Normal Quality)
One Disc (VCD) = ~68 minutes

Data Recording
One Disc =~700 MB

Caution: You may NOT change CD formats once the original layout is created.

» This DVD recorder adopts the DVD+VR record-
ing format, which enjoys a relatively greater
compatibility. However, it is still likely that
recordings made with this recorder may not be
able to be played back on other DVD recorders or
DVD players.
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* This DVD recorder features ‘AllWrite™’
technology, which allows users to record on
almost all types of recordable and rewritable
discs (CD-R/RW, DVD-R/RW, DVD+R/RW).
However, it is still likely that certain brands of
discs cannot be used for recording on this DVD
recorder. For best results, please visit our website
for a list of recommended discs.

Please note that you may not be able to success-
fully record a program, if the source material

is copy-protected (e.g. set in ‘Copy-Once’ or
‘Copy-Never’ modes).

Recording from TV

Before you start...

Make sure all the cables are correctly con-
« nected to the DVD recorder.

/\ Connecting up Your DVD Recorder (p.12)

Check whether the channel scanning process
« for your TV is completed.

(%, Setting TV Channels (p.19)

Check whether you select and insert a record-
« able disc.

., Guide to Using the Discs (p.93)

Check whether there is enough space on the
« disc or on the hard drive.

Recording on Disc

Press SETUP to display the Setup menu.

Press a w to select ‘Recording’, then press »
to enter the sub-menu.

Press a ¥ to select a recording mode, then
press ENTER.

SETUP

Recording

Mode SP HO

Chapter Mark 5 minutes [@SP.
LP
EP
SLP

When completed, press SETUP to exit the
Setup menu.

Press 2 OPEN/CLOSE to open the disc tray.

Carefully place the disc in the tray with the
label side facing up, then press 2 OPEN/
CLOSE.

Press TV/MODE or SOURCE to select ‘TV
as the signal source.

By default, pressing TV/IMODE allows you to switch to TV
directly. However, if you have activated the ‘SCART Bypass’

mode earlier through Setup menu, you can only press
SOURCE 1o switch to TV.

If you press SOURCE, you may need to press the button
more than once to switch to ‘TV’.

E Press CHa and CH + to select desired
channel.

CH 28 CH 68

—

| (INote.

* You can press number buttons (0-9) to select a
channel. When completed, press ENTER for
confirmation. (For Channel 6, press 6, then EN-
TER. For Channel 55, press 5, 5 and ENTER.)

Press ® RECORD to start recording.

SP] 0:00:11 / 2:00:00 Recording

E Press I PAUSE/STEP to pause recording
Press B STOP to stop recording.

E Press ® RECORD again if you need to start
another recording session.

Recording on Hard Drive

Press SETUP to display the Setup menu.

Press a ¥ to select ‘Recording’, then press »
to enter the sub-menu.

Press a ¥ to select a recording mode, then
press ENTER.

A Guide to Recording Options (p.96)
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SETUP Recording

Mode SP HO

Chapter Mark 5 minutes |[®SP
LP
EP
SLP

“, Guide to Recording Options (p.96)

When completed, press SETUP to exit the
Setup menu.

Press HDD/DVD to select ‘HDD’ (hard drive)
as the target medium.

Press TV/MODE or SOURCE to select ‘“TV’
as the signal source.
By default, pressing TV/MODE allows you to switch to TV
directly. However, if you have activated the ‘SCART Bypass

mode earlier through Setup menu, you can only press
SOURCE to switch to TV.

>

If you press SOURCE, you may need to press the button
more than once to switch to ‘TV".

Press CHa and CH v to select desired
channel.

CH 28 CH 68

e

| (INote.

* You can press number buttons (0-9) to select a
channel. When completed, press ENTER for
confirmation. (For Channel 6, press 6, then EN-
TER. For Channel 55, press 5, 5 and ENTER.)

E Press ® RECORD to start recording.
sp]

0:00:11/ 2:00:00 Recording

Press I» PAUSE/STEP to pause recording
Press B STOP to stop recording.

E Press ® RECORD again if you need to start
another recording session.

Recording from VCR/V8
GCamcorder

Before you start....

Make sure all the cables are well connected
« from external device’s AV OUTPUT jacks to
the recorder’s AV INPUT jacks.

Audio/Video Cable —s

* When using the S-Video jack to connect your
external equipment, please check whether you
have switched on the connection mode in the
Setup menu. Make necessary adjustment through
SetuplORecordingFront AV.

Press SOURCE repeatedly to select the correct
signal source.

TV — Front AV
C— DV =— SCART _:>
Cue the external device and start playback at

the beginning of the scene you wish to record.

Press HDD/DVD to select your target medium.
If you would like to record on disc, press &
OPEN/CLOSE to open the disc tray, and
place a recordable disc in the tray. Press &
OPEN/CLOSE again to close the tray.

Press ® RECORD to start recording.

0:00:11 / 2:00:00

| ©m sP]

Recording

Press P PAUSE/STEP to pause recording
Press ® STOP to stop recording.

E Press ® RECORD again to start another
recording session.
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Recording from DV [Digi-
tal Camcorder]

.“1 Important

* The DV-Link INPUT jack on this recorder is for
use with DV-compatible camcorders only.

* Only DV signals can be input to the DV-Link
jack on this DVD recorder.

¢ Do not connect a MICRO MV format video
camcorder to the DV-Link jack.

» Despite the technology endeavour with which
this DVD recorder is built, it is still likely that
your DV may not be fully supported by the
recorder.

Before you start...

Check whether the DV is correctly connected
« to the inputs of this recorder.

DV / Link

?

Camcoder DV-Link J

IEEE 1394
DV ouT

Recording with ‘Rec Link’

The ‘Rec Link’ feature allows you to easily record
materials from DV with the recorder’s remote
control. This function is automatically activated
when you connect your DV to the DVD recorder.

Press SETUP to display the Setup menu.

Press a v to select ‘Recording’, then press »
to enter the sub-menu.

Press a ¥ to select a recording mode, then
press ENTER.

// Guide to Recording Options (p.96)
When completed, press SETUP to exit the
Setup menu.

Press SOURCE repeatedly to select ‘DV’ as
the signal source.

@W ORECLink
[m] > f«]m]oe-e]

The control pad will be displayed with the ‘Rec Link’ feature
enabled.

Press HDD/DVD to select your target medium.
If you would like to record on disc, press &
OPEN/CLOSE to open the disc tray, and place
a recordable disc in the tray. Press 2 OPEN/
CLOSE again to close the tray.

Press ® RECORD to start recording.

SP] 0:00:11 / 2:00:00 Recording

E Press B STOP to stop recording.

Recording without ‘Rec
Link’

Press SETUP to display the Setup menu.

Press a ¥ to select ‘Recording’, then press »
to enter the sub-menu.

Press « ¥ to select a recording mode, then
press ENTER.

‘f:ii; Guide to Recording Options (p.96)

When completed, press SETUP to exit the
Setup menu.

Press SOURCE repeatedly to select ‘DV” as
the signal source.

Press « v < » to select ‘Rec Link’ button on
the screen, then press ENTER to switch off the
function.

After switching off the function, you can control your DV

either through the on-screen control pad using ~ v 4 »
and ENTER buttons, or through the control keys on DV,
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G| v

=11 ORECLink
[ml»[u]«n]ee]

Press a v < » to select your desired function,
then press ENTER. Cue the DV at the begin-
ning of the scene you wish to record.

E Press HDD/DVD to select your target medium.
If you would like to record on disc, press &
OPEN/CLOSE to open the disc tray, and
place a recordable disc in the tray. Press &
OPEN/CLOSE again to close the tray.

Press ® RECORD to start recording.

0:00:11 / 2:00:00

| ©m sP]

Recording

E Press II® PAUSE/STEP to pause recording
Press ® STOP to stop recording.

E Press ® RECORD again if you need to start
another recording session.

One-Touch Recording

When all recording settings are confirmed,
press ® RECORD twice to instantly start a
30-minute recording session.

For longer recording hours, press ® RECORD
repeatedly, which will offer you a length option
of up to 6 hours in 30-minute increments.

Press II» PAUSE/STEP to pause recording.
Press mSTOP to stop recording.

Press ® RECORD again if you need to start
another recording session.

| (Note.

* ‘One-Touch Recording’ will start with the
DVD recorder’s default settings, if you do not
make any setting changes before activating this
function.

 The overall recording time depends on the
selected recording mode and the storage capacity
available on your target medium.

» Recording will stop automatically when there is
no more space on your target medium or after 6
hours of recording (whichever happens first).

Adding New Recording
Session(s]

After the previous recording is stopped, press
@ RECORD again to start another recording
session.

Press P PAUSE/STEP to pause recording
Press mSTOP to stop recording.

Press ® RECORD again if you need to start
another recording session.

Su1p1022Yy y N

| (INote.

» Each new recording session is placed after the
previous session unless a certain recorded title is
set to be overwritten.

&, Overwriting a Title (p.76)

Playing Last Recorded
Title (On Hard Drive Only)

Direct Playback

Press HDD/DVD to switch to HDD.
Press » PLAY.

Playback of the last recorded title will then
start.

Using Easy Guider

Press GUIDER to display the Easy Guider
menu.

On the Easy Guider menu, press « v to select
‘Play’, then press ENTER.
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Press a w to select ‘HDD?’, then press
ENTER.

Press a w to select ‘Last Recorded’, then
press ENTER.

Playback of the last recorded title will then
start.

E Press IP PAUSE/STEP to pause playback.
Press » PLAY to resume normal playback.
Press ® STOP to stop playback at a marked
stop.

Press @ STOP again to bring the playback to
a full stop.

Using Chapter Mark

.“1 Important

Manually or by default, this DVD recorder allows
you to add chapter marks in your recordings. De-
pending on the target medium you use, allowance
for maximum chapters and titles you can add may
vary. Please see the table listed below for details.

Per Title Per Disc
Media Maxi. Maxi. Maxi.
Chapter Chapter Title
HDD 999 NA 5994
DVD 99 254 49
99 (Music)
CD NA NA
98 (Video)

Changing Chapter Interval

During recording, this DVD recorder can automati-
cally divide a session into chapters by inserting
chapter marks. You can select a preferred interval
through the Setup menu.

Press SETUP to display the Setup menu.

Press a ¥ to select ‘Recording’, then press
ENTER.

SETUP

Recording

Mode SP HQ

Chapter Mark 5 minutes o SP

Front AV Composite LP
EP

SLP

(o]
[S]
EQ
[+

«x]

Press a ¥ to select ‘Chapter Mark’, then press
ENTER.

SETUP

Recording

Mode SP off

Chapter Mark 5 minutes ® 5 minutes
10 minutes
15 minutes
20 minutes
25 minutes

30 minutes

3] &) (2] [e][

Press a ¥ to select your desired interval, then
press ENTER.

When completed, press 4 to return to the main
menu.

E Press 4 or SETUP to completely exit the
Setup menu.

Inserting Chapter Mark
during Recording

During recording, you can manually insert extra
chapter marks in addition to those created by
system default setting.

Press SOURCE repeatedly to select the signal
source.

Press ®@ RECORD to start recording.

During recording, press EDIT to insert chapter
mark at your desired point.

SP| 0:00:11/2:00:00  Chpater Inserted

To add more chapter marks, repeat step 3.
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Timer
Recording

his chapter introduces the timer record-

ing function offered by this DVD recor-—
der. Please follow the steps listed below for
the application.

* Introducing Timer Record Menu.............. 52
* Setting Timer Program(Date/Time Mode)..53
*Setting TimerProgram(ShowView®Mode)..55

Timer Recording

Make use of the timer recording feature to record
programs and watch them at your leisure.

.‘g Important

¢ If you use blank DVD-RW discs, you will need
to format the discs before recording. Press a v to
select ‘Quick Preparation’ or ‘Full Preparation’,
then press ENTER.

Please select method for preparing disc

Quick Preparation
@ A Disc requires finalization after recording

,‘/‘ Full Preparation(30~60 minutes)
@ Prepare disc for play in other DVD players

* If you use blank CD-R/RW discs, you will
need to format the discs before recording. Press
4 v 4 » toselect a suitable format, then press
ENTER.

Please select recording format.

e

Audio CD
Audio Recording Video Recording (Better Quality)
One Disc = ~70 minutes One Disc (SVCD) = ~34 minutes

Video Recording (Normal Quality) Data Recording
One Disc (VCD) = ~68 minutes One Disc =~700 MB

Caution: You may NOT change CD formats once the original layout is created.

* This DVD recorder adopts the DVD+VR record-
ing format, which enjoys a relatively greater
compatibility. However, it is still likely that
recordings made with this recorder may not be

able to be played back on other DVD recorders or

DVD players.
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* This DVD recorder features ‘AllWrite™’
technology, which allows users to record on
almost all types of recordable and rewritable
discs (CD-R/RW, DVD-R/RW, DVD+R/RW).
However, it is still likely that certain brands of
discs cannot be used for recording on this DVD
recorder.

Before you start...

Check whether the system date and time of
« the DVD recorder is correct.

1, Setting System Date (p.16)

Setting System Time (p.17)

Check whether the channel scanning process
« for your TV is completed.

Setting TV Channels (p.19)

Check whether you select and insert a record-
« able disc.

«

Guide to Using the Discs (p.93)

Check whether there is enough space on the
« disc or on the hard drive.

Introducing Timer Record
Menu

Press TIMER to display the Timer Record menu.

You can press » on a highlighted program to switch
between the ‘Date/Time Setting” mode and the
‘ShowView Setting’ mode.

Date/Time Mode

TIMER RECORD

Q [ 1hoom--sp @i 12/04/05  Sunday
9 [ 33n25m-sp @{i 08:09PM
@Tlme Overlap !! @qe 1/2
Source Repeat  Date Time
T Once@ 01/04/05 . 09:00PM~1 M@
T £ |once \ [03/04/05 11:00AM- 1 @ M >
v 13 Oifonce  o4/04/05 18:00PM-18:30PM[ /N
@‘e TV 8 [Olweekly [Mon. Tue 06:00PM~08:00PM
%) TV 6 (o)[once  [12/04/05 _ [07:30PM-09:00PM
v 12 once 15/04/05 11:00PM~11:30PM
v 33 [Qonce 18/04/05 _ [04:00AM-05:004M
v 7 @][once 19/04/05  [05:00PM-07:00PM

@vecre || @

1. Indicates the storage capacity available on the
destination disc for a particular recording mode.

2. Indicates the current system date.
3. Indicates the current system time.
4. Indicates the page you are viewing.
5. Indicates the error message bar.

6. Indicates the function of canceling Timer
Program. Press to clear settings.

7. Indicates the TV channel(s) from which you
would like to record program(s).

8. Indicates the assigned target device.
9. Indicates the assigned recording frequency.

10. Indicates the assigned date of your desired
program(s).

11.Indicates the assigned time of your desired
program(s).

12.Indicates the status of preset Timer Program(s).
(M : Timer Program successfully activated.

/N : Timer Program not successfully activated.

13.Indicates the ‘Next Page’ function. Press to
switch to the next page.

14.Indicates the ‘Exit’ function. Press to exit the
Timer Record menu.
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[GNote]

* The Timer Program list is automatically sorted
by system according to the start time of each
program, regardless of its recording mode or
recording frequency.

For example, regardless of the order you enter
the timer settings, the system will automatically
list preset programs in the following sequence
according to the start time of each program.

Source | Repeat Date Time

Ch.a | Weekly (Bvery 13101005 | 07:00~08:00
Mondays)

Ch.6 | Once 31/01/05 | 13:00~14:30
Daily (Monday

h. 1/01 19:00~20:

Ch.3 | i rongh Sunday) | 210103 9:00~20:00
Daily (Monday ] )

Ch.3 | | ough Sundagy | 00205 | 19:00-2000

ch.3 | DallyMonday 1) 0005 | 19:00~20:00
through Sunday)

ch.a | Weekly (Bvery 000005 | 07:00~08:00
Mondays)

* This DVD recorder allows users to set up a
maximum of 32 programs for timer recording,
which will be displayed on four separate pages. If
the number of preset programs is less than eight,
only one page will be shown, and the ‘Next Page’
button will be disabled.

ShowView Mode

TIMER RECORD
(D‘:?”\'} I 1noom-sp @i 12/04/05  Sunday
O [T 33h25m-sp @ os:09pPM

Page 1/1

ShowView 4 5 Mode @ PDC s@
[ [

New Timer Program((8 ) 3

Exit 9

1. Indicates the storage capacity available on the
destination disc for a particular recording mode.

2. Indicates the current system date.
3. Indicates the current system time.
4. Indicates the page you are viewing.

5. Indicates the ShowView® number of your
desired TV program(s).

. Indicates the assigned recording mode.

. Indicates the sound option selected for the

program.

. Indicates a new Timer Program. Press to start

setting a Timer Program.

. Indicates the ‘Exit’ function. Press to exit the

Timer Program menu.

Setting Timer Program
(Date/Time Mode)

Press TIMER to display the Timer Record

menu.

Press ENTER to start new setting, or press

a v to select a previous setting which you
would like to modify.

Press « ¥ to select ‘Source’, then press

ENTER. Press a v to select the singal
source, then press ENTER.

If you select “TV’ as the signal source, press

a v or number buttons (0-9) to enter the
channel number, then ENTER.

Press a v to select ‘HDD/DVD?’, then press

ENTER. Press « v to select the target
medium, then press ENTER.

E Press « v to select a recording mode, then

press ENTER.

Press a w to select ‘Repeat’, then press

ENTER.

Once

If you select ‘Once’, you need to set the date.
Press « v < » or number buttons (0-9) to
enter the date.

Daily

If you select ‘Daily’, you do not need to set the
date, since the Timer Record program will be
automatically set for each day until the setting
is cancelled or the target medium has no more
storage capacity.

Weekly
If you select “Weekly’, a weekly calendar will
appear for you to select the day.
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TIMER RECORD

Source v

Channel 12
HDD/DVD HDD
Mode SP

SUN
Repeat Weekly E MON
Date & |[J71ue | [l 12/04/05 Sunday
start | 1800 || LJWED | (3 og0opM
] THR
e L1900 Ay T 1hoom-sp
Sound | Stereo || M sar | [©) ]I 33n25m--sp
PDC/VPS off oK

‘ Cancel ‘ Advanced | [ ShowView

Press a « to select desired day(s), then press
ENTER to confirm your selection. When
completed, press « v to select ‘OK, then
press ENTER.

| (INote.

* You can select more than one day for the weekly
mode. For example, if your desired programs are
broadcast every Thursdays and Fridays, you can
assign the timer setting only once by selecting
both Thursday and Friday.

* Ifyou select ‘Daily’ or “Weekly’ for timer
recording, it is suggested that you use further
commands for more effective application.

Press a v 4 » to select ‘Advanced’, then press
ENTER. Choose whether or not to designate a
period of time to your Timer Programs by select-
ing ‘With restriction’ or “Without restriction’.

In ‘Daily’ mode:

Options Recording Results

The preset program will be
With restriction recorded every day during the

designated period of time.

Without
restriction

The preset program will be
recorded every day continuously.

In ‘Weekly’ mode:

Options Recording Results

The preset program will be
With restriction recorded .on certain (.1ay(s) ever?/
week during the designated period

of time.

Without The preset program will be

o recorded on certain day(s) eve
restriction ye) Y

week continuously.

E Press a w to select ‘Start’, then press ENTER.

Press a v < » or number buttons (0-9) to
enter the start time, then press ENTER.

E Press a v < » or number buttons (0-9) to
enter the end time, then press ENTER.

If you select “TV’ as the signal source, press
a v 4 » toselect ‘Sound’, then press
ENTER. Press ~ v to select the TV audio
mode, then press ENTER.

Press « v < » to select ‘PDC’, then press
ENTER. Press a + to switch on or off the
PDC function, then press ENTER.

Press a v to select ‘OK’, then press ENTER
to save the setting and return to the Timer
Record menu.

Press « v < » to select ‘Cancel’, then press
ENTER, if you would like to discard current
setting.

Press a ¥ to select another item on the list,
then press ENTER, if you would like to set up
more Timer Programs.

If not, select ‘Exit’, then press ENTER. Or
press TIMER to exit the Timer Record menu.

To stop a timer-recording session:

Press @ STOP to cease the timer recording. Please
note that it may take a few seconds before the
program is completely brought to an end.

To check the recording status while ‘Timer
Record’ is active:

Press DISPLAY to bring up the Timer Record
information on screen.

| (Note.

* This DVD recorder allows you to set up a maxi-
mum of 32 Timer Programs. If your setting list
is full, you need to delete some of the programs
before you can input new ones.

* This DVD recorder allows you to use a maximum
of 20 PDC settings for your preset Timer Pro-
grams. If you have used up the quota, you need
to cancel the setting on some preset programs
before you can assign the feature to other timer
recordings. Meanwhile, please be reminded that
the PDC is applicable only when your DVD
recorder is in standby mode. If you have been
using the DVD recorder before a preset Timer
Program starts, it will not be monitored by the
PDC system., and the preset Timer Program will
begin following the original schedule.

* This DVD recorder features ‘power-on’ timer
recording: you do not need to switch off the
recorder to activate the function.
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(2 Why This Happened

Why is my preset program not completely
recorded?

Incomplete recording may be resulted from:

* Insufficient space

If there is not enough space on the target medium,
your preset program can only be partially recorded
depending on the amount of capacity available.

* Overlapped Timer Program settings

The unfinished recording may occur when time
settings of two Timer Programs overlap. Under
the circumstances, the DVD recorder stops record-
ing the earlier program at the start time of the

later program. (The black bars represent contents
recorded.)

Pogom | ]
Progrm 2 —

Pogom | ]
Program 2 —

Setting Timer Program
[(ShowView® Mode)

There are two ways to set up Timer Programs using
the ShowView® system. For more information on
how to set up the system, please see ‘Setting the
ShowView® System’.

Path 1:

1. Press the ShowView button to display the
ShowView menu.

Path 2:

1. Press TIMER to display the Timer Record
menu.

2. Press ENTER to start new setting, or press « v
to select a previous setting which you would like
to modify, then press ENTER.

3. Press a v € » to go to the ‘ShowView’ button,
then press ENTER to display the ShowView
setup menu.

Press a v < » or number buttons (0-9) to
enter the ShowView® number, then press
ENTER.

TIMER RECORD

ShowView | 12345

Channel 015
Date 12/16/05
Time 11:30 PM

Length 060 minute]

Repeat [ Once [Tl 12/04/05 Sunday
HDD/DVD HDD (9 08:09PM
Mode [T 1hoom-sp
Stereo Stereo @ [T 33h25m--sp
PDC/VPS off
I oK ‘ ‘ Cancel ‘ [Date/Time Setting |

Details of the preset program will be displayed.

The ‘Preset Channel’ dialogue box will appear,
if the DVD recorder fails to find information of
a corresponding channel. Presss « v < » or
number buttons (0-9) to enter the channel num-
ber shown on your TV, then press ENTER.

TIMER RECORD

ShowView | 12345

3u1p1022y] 1oui1] y N

GCN Preset Channel
Repeat L [:> ay
HDD/DVD - 149 a O 0
Mode | P | [T 1hoom-sp
Stereo Stereo Q |:- 33h25m--SP
PDC/VPS Off
I oK ‘ ‘ Cancel ‘ [Date/Time Setting |

| (}Note.

* To make use of the ShowView® system for timer
recording, you need to match the GCNs (guide
channel numbers) used by the ShowView®
system with the channel numbers shown on
your TV, so that the relevant information can be
correctly assigned to the programs you would
like to record.

Press « v to select ‘Repeat’, then press
ENTER. Press a ¥ to select a recording
frequency (Once/Daily/Weekly), then press
ENTER.

Press a v to select ‘HDD/DVD?’, then
press ENTER. Press a w to select the target
medium, then press ENTER.

Press a v to select a recording mode, then
press ENTER.

Press a w to select ‘Sound’, then press
ENTER. Press « v to select the TV audio
mode, then press ENTER.

Press « wto select ‘PDC’, then press ENTER.
Press a w to switch on or off the PDC func-
tion, then press ENTER.
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E Press a v to select ‘OK’, then press ENTER
to save the setting and return to the Timer
Record menu.

Press « v < » to select ‘Cancel’, then press
ENTER, if you would like to discard current
setting.

E Press a « to select another item on the list,
and press ENTER if you want to set up more
Timer Record programs.

If not, select “Exit’, then press ENTER. Or
press TIMER to exit the Timer Record Menu.

[ONote]

* If you would like to return to the Date/Time
mode, press « v € » to select ‘Date/Time
Setting’, then press ENTER. Please note that all
the settings you have entered will be cleared once
you exit the present setup screen.

* This DVD recorder allows you to set up a maxi-
mum of 32 Timer Programs. If your setting list
is full, you need to delete some of the programs
before you can input new ones.

* This DVD recorder allows you to use a maximum
of 20 PDC settings for your preset Timer Pro-
grams. If you have used up the quota, you need
to cancel the setting on some preset programs
before you can assign the feature to other timer
recordings. Meanwhile, please be reminded that
the PDC is applicable only when your DVD
recorder is in standby mode. If you have been
using the DVD recorder before a preset Timer
Program starts, it will not be monitored by the
PDC system, and the preset Timer Program will
begin following the original schedule.

* This DVD recorder features ‘power-on’ timer
recording: you do not need to switch off the
recorder to activate the function.

@ Why This Happened

Why is my preset program not completely
recorded?

Incomplete recording may be resulted from:

* Insufficient space

If there is not enough space on the target medium,
your preset program can only be partially recorded
depending on the amount of capacity available.

* Overlapped Timer Program settings

The unfinished recording may occur when time
settings of two Timer Programs overlap. Under
the circumstances, the DVD recorder stops record-
ing the earlier program at the start time of the

later program. (The black bars represent contents
recorded.)

Pogom | ]

Program 2

Pogom | ]
—

Program 2
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[ @) Important]

Please note that if the source materials you are
viewing are copy-protected, you will not be able to
make use of the ‘Time Shift’ function.

Yiys oun] g

Q Before you start

Check whether the video signal of this DVD
« recorder is correctly displayed on your TV
screen.

‘i, Connecting up Your DVD Recorder (p.12)

Check whether the channel scanning process
o for your TV is completed.

(&, Setting TV Channels (p.19)

Check whether there is enough space on the
« hard drive.
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Pausing Live TV Broadcast

Live program pause offers you great flexibil-
ity when watching TV. Press TIME SHIFT to
pause the program you are viewing, and come
back later to watch from where you left off.

.‘g Important

The maximum time for live program pause is 3
hours.

Before you start...

Check whether the video signal source of your
e TV is switched to the DVD recorder.

Press CHa and CH v to select a desired
channel.

Press TIME SHIFT to pause the program you
are currently watching.

) Timeshift | 0:00:00 / 0:00:15 1l

The scene displayed on the TV screen will be the last picture

shown when you press TIME SHIFT.

Press » PLAY when you decide to go back to
watch the program. The program will then be
played back from where it is interrupted.

Press P PAUSE/STEP to pause playback.
Press » PLAY again to resume playback.

Press TIME SHIFT to switch off the function,
and return to the normal TV-viewing mode.

Record and Play
(On Hard Drive Only]

During recording or timer recording, press »
PLAY to start playback of contents recorded
on the hard drive.

Playback will then start from beginning of the
recorded session.

SP] 0:00:11 / 0:05:26 > ®

Press I PAUSE/STEP to pause playback.
Press » PLAY again to resume playback.
Press ®m STOP to stop playback.

Press B STOP again to stop the recording
completely.

[ Note

* You can only use this function when the record-
ing has been in progress for at least 10 seconds.
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| @ Important]

* Please note that it is likely you may not be able to
play back discs which contain contents recorded
in other DVD recorders.

* This DVD recorder can only play DVD-Video
discs marked with the same region code as
printed on its rear panel. If you try to play discs
with differnt region code(s), a message saying
‘Invalid Region Code’ will appear on screen.

Example of region code:
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Introducing Navigation
Menu

During playback, press NAVI. button on the remote
control to display the Navigation menu.

Before you start...

The options shown on the Navigation menu

« vary depending on the media types (e.g.
DVD, audio CD, VCD, etc.) as well as the
supporting features offered by the media being
played. Unavailable options will be disabled.

When playing DVD-Video discs or video titles ...

Repeat
Zoom

Slow Motion 4
Search 4
AB Repeat »
Subtitle 4
Audio 4
Angle »
Information 4
Exit

When playing VCD or SVCD ...

Repeat
Zoom

Slow Motion
Search

A-B Repeat
Audio

Sound
Information
Exit

vVvVvwvw

When playing video files...

Repeat
Zoom

Search 14
A-B Repeat >
Information 13

Exit

When playing audio CDs or music files...

Repeat

Search >
A-B Repeat 4
Information 14
Exit

When playing pictures...

Repeat

File Search >
Picture Control )
Information »
Exit

The ‘Repeat’ feature allows you to repeat a track,
title, file or disc, depending on the media type.

Press « v < » to select ‘Repeat’, then press
ENTER repeatedly to choose a repeat mode.

Content Type Repeat Mode

DVD-Video / CRepeat One
Video Title Repeat Off

Repeat All
VCD/SVCD —)
Repeat Off <«

Repeat One = Repeat All
Video File >
Repeat Off

Repeat One = Repeat All
Audio CD ’
Repeat Off

Repeat One = Repeat All
Music File )
Repeat Off

Repeat All
Picture )
Repeat Off <

Press NAVI. again or repeatedly press ¢ to
exit the Navigation menu.
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Zoom (For DVD-Video/
Video Title)

The ‘Zoom’ feature allows you to enlarge the
video image and to pan through the enlarged image
during playback.

Press a w to select “Zoom’, then press
ENTER.

@ | @
100%

=]
WL
~

Exit

A control pad will appear.

Press a v <« » to select the ‘zoom in’ icon,
then press ENTER repeatedly to enlarge the
video image by 100%, 200%, 300% or 400%.
Or, select the ‘zoom out’ icon, then press
ENTER repeatedly to reduce the video image
by 400%, 300%, 200% or 100%.

To resume the normal video image size, press
a v < » toselect the “100%’ button, then
press ENTER.

To view different sections of the enlarged
image, go to the on-screen control pad. Press
a v < »toselect the direction you would like
to apply, then press ENTER.

Press ENTER repeatedly, if necessary, to
move the image.

When completed, press « v < » to select
‘Exit’, then press ENTER.

Picture Control (For Pic-
tures)

The ‘Picture Control’ function not only allows you
to enlarge or reduce the picture image, but also
makes it possible to pan through the image for
more detailed viewing.

Press a w to select ‘Picture Control’, then
press ENTER.

Q Q

)

Fit Screen
Full Size

=]
b
~

Exit

A control pad will appear.

Press a v € » to select the ‘zoom in” icon,
then press ENTER repeatedly to enlarge the
picture by 1/2X, 3/4X or 1X. Or, select the
‘zoom out’ icon, then press ENTER repeatedly
to reduced the picture by 3/4X, 1/2X or 1/4X.

To resume the normal picture size, press
a v < » toselect ‘100%’, then press EN-
TER.

To view different sections of the enlarged
picture, go to the on-screen control pad. Press
a v < ) to select the direction you would like
to apply, then press ENTER.

Press ENTER repeatedly, if necessary, to move
the picture.

When completed, press « v € » to select
‘Exit’, then press ENTER.

Slow Motion

Press a + to select ‘Slow Motion’, then press
ENTER to go to the sub-menu.

Press a + to select from the options:
s 1/2x, -+ > 1/4x, «--- 1/2x or «--* 1/4x,
then press ENTER.

Press » PLAY to resume normal playback.
Press NAVI. again or repeatedly press 4 to exit
the Navigation menu.

You can search a disc which contains video files
or titles by entering the title/chapter number or by
entering a specific time. A similar function is also
offered when you play back audio CDs or other
supported music files.

To preform the function when playing video
files/titles, press « v to select ‘Search’, then press
ENTER to go to the sub-menu.
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To search by title/chapter number:

To search by chapter/title number, press « v
to select ‘Title/Chapter’, then press ENTER.

Press « v < » or number buttons (0-9) to
enter the numbers, then press ENTER.

Repeat

Zoom

Slow Motion »

Search »

A-B Repeat »

Subtitle »
»
»
»

Title/Chapter
Time

Ba/or

fAudio
Angle
Information
Exit

The bar for entering the title/chapter number will appear.

If during the process you would like to revise
the number you enter, press 4 to re-edit the last
digit(s) when necessary.

Press NAVI. again or repeatedly press 4 to exit
the Navigation menu.

| (Note.

« If the number you enter exceeds total title/chapter
number, an invalid icon will appear, and the
recorder will keep playing back the disc.

* If you would like to see the total number of
title/chapter, please go to ‘Information’ on the
Navigation menu.

 This function will be disabled, if not available.

P About ‘Title and Chapter’

For DVD-Video or other digital videos, disc
contents are usually divided into individual titles,
which you may preview using the disc menu.
Some titles may be further divided into a smaller
unit called ‘chapter’. To view the disc menu,
press MENU on the remote control to activate the
function.

~ [ritle Title B
- g - \
- \
_ 7 Title B \
T T
| |
Chapter1 : Chapter2 : Chapter3
JAN JAN

To search by time:

To search by time, press « ¥ to select ‘Time’,
then press ENTER.

Press « v < » or number buttons (0-9) to
enter the numbers, then press ENTER.

Repeat

Zoom

Slow Motion >

Search >

4-B Repeat »

Subtitle »
»
»
>

Title/Chapter
Time

Audio Blo:o00:00

Angle

Information
Exit

The bar for entering time will appear.

If during the process you would like to revise
the number you enter, press ¢ to re-edit the
last digit(s) when necessary.

Press NAVI. again or repeatedly press 4 to exit
the Navigation menu.

| (Note

* If the number you enter exceeds total time, an
invalid icon will appear, and the recorder will
keep playing back the disc.

* If you would like to see the overall time, please
go to ‘Information’ on the Navigation menu.

A-B Repeat

Press « v < » to select ‘A-B Repeat’, then
press ENTER to go to the sub-menu.

When playback reaches the beginning of your
desired session, press « ¥ to select ‘Set Point
A’, then press ENTER.

Repeat

Zoom

Slow Motion »

Search »

A-B Repeat >

Subtitle »
»
»
»

® Set Point A
Set Point B
fAudio Cancel

Angle

Information
Exit

When playback reaches the end of the desired
session, press a v to select ‘Set Point B’, then
press ENTER.

62



Repeat
Zoom

Slow Motion
Search

A-B Repeat
Subtitle
fAudio

Set Point A
® Set Point B
Cancel

fingle
Information
Exit

vVvVvVvevVew

Repeat from point A to point B will start.

To cancel the repeat mode, press « v to select
‘Cancel’, then press ENTER.

E Press NAVI. again or repeatedly press 4 to exit
the Navigation menu.

| (INote.

« If you exit the function, setting only point A, the
preset point A will still be valid when you enter
the ‘A-B Repeat’ function next time.

* The ‘Cancel’ function is only available when
both point A and point B are set.

» The ‘A-B Repeat’ setting will be canceled when
you bring the program to a marked stop or a full
stop.

Subtitle

Some pre-recorded DVD discs have more than one
subtitle language. The language initially selected
for playback will be the one you select when you
first set up the DVD recorder. Nevertheless, you
can change the subtitle language of the disc at any
time.

., Setting Language (p.16)

Press a v to select ‘Subtitle’, then press
ENTER to go to the sub-menu.

Repeat
Zoom
Slow Motion >
Search »
A-B Repeat »
Subtitle )| e oOff
»
»
»

fAudio Chinese
Aingle English
Information
Exit

Press a ¥ to select a subtitle language, then
press ENTER.

Repeat
Zoom
Slow Motion >
Search »
#4-B Repeat »
Subtitle > off
»
»
>

fAudio e Chinese
Angle English
Information
Exit

Press NAVI. again or repeatedly press 4 to exit
the Navigation menu.

| (INote.

 This function will be disabled, if not available.

Some pre-recorded DVD discs have more than one
audio language. The language initially selected for
playback will be the one you select when you first
set up the DVD recorder. However, you can change
the audio language of the disc at any time.

1, Setting Audio Output (p.18)
Press a ¥ to select “‘Audio’, then press
ENTER to go to the sub-menu.

Press a ¥ to select an audio language, then
press ENTER.

Repeat

Zoom

Slow Motion »

Search »

A-B Repeat »

Subtitle »
»
»
»

fAudio
Angle
Information
Exit

e Chinese (DD)
English (DD)

Press NAVI. again or repeatedly press 4 to exit
the Navigation menu.

| (INote.

 This function will be disabled, if not available.

* When VCD/SVCD is selected for playback,
audio options will be: Normal, SWAP, Left and
Right.
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Angle

Some pre-recorded DVD discs contains scenes shot
from different camera angles. You can choose to
view these camera angles during playback.

Press a v to select ‘Angle’, then press
ENTER to go to the sub-menu.

Press a ¥ to select a camera angle, then press
ENTER.

Repeat
Zoom

Slow Motion >
Search >
A-B Repeat »
Subtitle >
Audio >
Angle 4
Information 14
Exit

Press NAVI. again or repeatedly press 4 to exit
the Navigation menu.

| (INote.

 This function will be disabled, if not available.

Information

During playback, you can select to show the disc
information on the top of the screen or to hide it.

Press a « to select ‘Information’, then press
ENTER to go to the sub-menu.

Press a v to select ‘On’ or ‘Off”, then press
ENTER.

Title 01/08
Subtitle
Display

001/001  Time 00:00:27
Audio Total 00:03:04
Sound DD Angle 11

Title 01 Chpater 001 0:00:27 »

Chpater

4:3

Repeat
Zoom
Slow Motion »
Search >
A-B Repeat >
Subtitle »
Audio >
Angle »
>

Information e On

Exit off

If you select ‘On’, disc information will be displayed on the
top of the screen.

Press NAVI. again or repeatedly press ¢ to exit
the Navigation menu.

| (Note.

« Different categories of information will be shown
depending on the media type.

Playing DVD-Video Disc

Press 2 OPEN/CLOSE to open the disc tray.

Carefully place the disc on the tray with the
label side facing up, then press 2 OPEN/
CLOSE.

If playback does not start automatically, press
» PLAY to begin playback.

A menu might appear when the disc is in playback mode.

Press a v € » to select an item and confirm
with ENTER.

If the titles and chapters are numbered, press number but-
tons (0-9) to select a menu item and confirm with ENTER.

Press B STOP to stop playback at a marked
stop.
Press » PLAY to resume playback from a
marked stop.
Press B STOP twice to bring the playback to
a full stop.

E To remove the disc, press 4 OPEN/CLOSE.

| (Note.

* If you would like to bring up the DVD menu,
press MENU on the remote control to display it.
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Playing VCD/SVCD Disc

Press 2 OPEN/CLOSE to open the disc tray.

Carefully place the disc in the tray with the
label side facing up, then press 2 OPEN/
CLOSE.

If playback does not start automatically, press
» PLAY to begin playback.

Press B STOP to stop playback at a marked
stop.
Press » PLAY to resume playback from a
marked stop.
Press B STOP twice to bring the playback to
a full stop.

To remove the disc, press 4 OPEN/CLOSE.

[ (Note

* This DVD recorder supports discs recorded with
multiple sessions.

Playing Audio CD

Normal Playback

Press 4 OPEN/CLOSE to open the disc tray.

Carefully place the disc in the tray with the
label side facing up, then press 2 OPEN/
CLOSE.

If playback does not start automatically, press
» PLAY to begin playback.

Press B STOP to stop playback.
Press » PLAY to resume playback.

To remove the disc, press 4 OPEN/CLOSE.

Programmed Playback

Press 2 OPEN/CLOSE to open the disc tray.

Carefully place the disc on the tray with the
label side facing up, then press 2 OPEN/
CLOSE.

If playback does not start automatically, press
» PLAY to begin playback.

Press EDIT to bring up the editing bar.

| Program 01 Track == |

Press the number buttons (0-9) to enter the
number of track you would like to play and
confirm with ENTER.

E When completed, press » PLAY to begin
playback.
Press m STOP to stop playback.
Press » PLAY to resume playback.

To remove the disc, press 4 OPEN/CLOSE.

[ (Note

» This DVD recorder supports discs recorded with
multiple sessions.

Playing Video File

Before you start...

Check whether the disc you insert contains
« video files.

In some cases, the disc recorded on other
« recorders need to be finalized before it can be
played back on this DVD recorder.

Press 2 OPEN/CLOSE to open the disc tray.

Carefully place the disc on the tray with the
label side facing up, then press 2« OPEN/
CLOSE.

Press CONTENTS to display the Contents
Menu.
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(& Video | [ 53] Music J[4]] Picture

[C®ovw &
D

001

TITLE 02 TITLE 03
07:32PM 02/14/15  05:45PM 03/06/05
00h06m18s HQ ~ 00hOOMOSs SP

TITLE 01
07:32PM 12:04/05
00h0OmMOSs  SP

o

TITLE 06
12:16AM 01/01/03  12:16AM 01/01/03  13:19AM 01/01/03
00h0OMO9s SP  00hOOM41s SP  00hOOM57s SP

001 ][ 002 ] I LT I I L1
H| Text View I Exit I

TITLE 04 TITLE 05

Pressa v 4 » to select the source medium,
then press ENTER.

Press ¢ » to select “Video’, then press
ENTER.

E Pressa v 4 » to select a video title, then
press ENTER.

Playback will then start.

E Press K¢ PREVIOUS or » NEXT to advance
or return to the previous or next chapter.

E Press ® STOP to stop playback at a marked
stop.
Press » PLAY to resume playback from a
marked stop.
Press ® STOP twice to bring the playback to
a full stop.

| (INote

* This DVD recorder supports discs recorded with
multiple sessions.

Playing Music File

Before you start...

Check whether the disc you insert contains
« music files.

Press 2 OPEN/CLOSE to open the disc tray.

Carefully place the disc on the tray with the
label side facing up, then press « OPEN/
CLOSE.

Press CONTENTS to display the Contents
Menu.

] video (3] music [ Picture [ @®0VD &
0
001
2 ) 1%
Default Ab§E)  0515_100 0575_101
107 Files  05/30 107 Files  05/30 44 Files
a2l Lw]] [
0515_102@E)  0515_10342)  0515_104 =)
05/30 38 Files  05/30 45 Files 05/30 99 Files
oorfrocz) T
e | Text View I Exit I

Pressa w 4 » to select the source medium,
then press ENTER.

Press ¢ » to select ‘Music’, then press
ENTER.

E Pressa v 4 » to select a music album, then
press ENTER to go into the album.

Press a « to select a music file, then press
ENTER.

E Playback will then start.

E Press B STOP to stop playback.
Press » PLAY to resume playback.

| (Note

 If an MP3 file name includes two-byte character,
it may not be displayed correctly.

* This DVD recorder does not support ID3 (for
MP3) and WMA tags.

* This DVD recorder does not support MP3-Pro
files.

* The MP3 file bitrates supported by this DVD
recorder are: 32Kbps - 320Kbps.

* This DVD recorder supports discs recorded with
multiple sessions.
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Playing Picture File

Before you start...

Check whether the disc you insert contains
« picture files.

Press 4 OPEN/CLOSE to open the disc tray.

Carefully place the disc on the tray with the
label side facing up, then press 2 OPEN/
CLOSE.

Press CONTENTS to display the Contents
Menu.

& Video J[J3] Music | [R4]] Picture [C@ovw &

[ e

Default Ab.gZ)  0515_100 0515_101
107 Files 05/30 107 Files  05/30 44 Files

[ [ )

0515_102QZ) O515_103§Z) 0515_104g5)
05/30 38 Files 05/30 45 Files 05/30 99 Files

oot Joo2]l T T | I |

o] Text View I Exit I

Pressa - € » to select the source medium,
then press ENTER.

Press ¢ » to select ‘Picture’, then press
ENTER.

E Pressa w < » to select a picture album, then
press ENTER to go into the album.

Pressa v 4 » to select a picture, then press
ENTER to start playback.

E Press < » to skip to the previous or next
picture.

E Press a repeatedly to rotate the picture clock-
wise, or press v repeatedly to rotate the picture
counterclockwise.

Press ® STOP to stop playback.
Press » PLAY to resume playback.

Playing Picture with
Music

This DVD recorder allows you to play back picture
and music files at the same time. You can use this
function either through the Contents Menu or
through Easy Guider.

Using Contents Menu

Press CONTENTS to display the Contents
Menu.

Pressa w 4 » to select the source medium,
then press ENTER.

Press ¢ » to select ‘Picture’, then press
ENTER.

Pressa w 4 » to select a picture album, then
press ENTER.

Pressa v 4 » to select a picture, then press
ENTER. Playback will then start.

E Press CONTENTS to display the Contents
Menu.

Press ¢ » to select “Music’, then press
ENTER.

E Pressa w 4 » to select a music album, then
press ENTER.

E Pressa w 4 » toselect a music file, then press
ENTER. Playback will then start.

Press 4 » to skip to the previous or next
picture.
Press a repeatedly to rotate the picture clock-
wise, or press v repeatedly to rotate the picture
counterclockwise.

Using Easy Guider

For more information on how to make use of the
simultaneous playback, please see ‘Using Easy
Guider: Play’.

[ONote|

* This feature is only applicable when there are
both picture and music files on the hard drive or
on the disc you insert.
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Igital
ideo
Support

his chapter introduces the playback

function offered by this DVD recorder
for users to watch the digital videos com—
pressed with the new MPEG—-4 technology.
Please follow the steps listed below for the
application.

MPEG=4. . . 68
e Supporting Formats..........cococeviiiiinnn.. 69
* Playing MEPG=4 FileS..........ccovvieeinn... 69
Navigation MenU..........cooovviiiiiiinnininn.. 70
o Subtitle...oo 70
DIVX® VOD ..o 71
» Step 1: Applying a User Account............ 71
» Step 2: Registering Your DVD Recorder....71
» Step 3: Selecting Video Files................. 72

MPEG-4

Built with the MPEG-4 support, this DVD recorder
allows you to watch MPEG-4-based videos with
your TV.

@ moortant

It is illegal to download and use unauthorized
copyrighted materials. Make sure you obtain the
permission or authorization from copyright owners
and related third-parties before you start using or
watching the videos or files. If you fail to do so,
you may be subject to fines and/or penalties.

Before you start...

Check whether the video signal of this DVD
« recorder is correctly displayed on your TV
screen.
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Supporting Formats

The MPEG-4 technology allows a large video

file, such as a two-hour movie, to be efficiently
compressed without sacrificing its original video
and audio quality. If you watch an MPEG-4-based
movie, there may be subtitle files saved for
playback in addition to the video/audio files. Please
check the table listed below to see whether your
MPEG-4 files are supported by this DVD recorder.

MPEG-4 File Formats Supported

Category Codec File Type
Standard
Movie Video | ¢ DivX AVI, MP4,
* XviD DIVX, DIV
Audio | « MP3
*AC3
« LPCM
Subtitle N/A SUB, SRT, TXT

| (Note.

* Bitmap-based subtitles, such as idx+sub, are not
supported by this DVD recorder.

Playing MEPG-4 Files

Press 2 OPEN/CLOSE to open the disc tray.

Carefully place the disc in the tray with the
label side facing up, then press « OPEN/
CLOSE.

If playback does not start automatically, press
» PLAY to begin playback.

If the file is not supported by the DVD
recorder, a dialogue box will appear. Press
ENTER to skip the file.

At least one of the following formats is not supported
by the DVD recorder. Playback cannot start.

Video Codec: 3ivx
Audio Codec: 0GG
Resolution: 1280 x 768

Skip This File

If the disc contains other files, the DVD
recorder will start playing back the next file.

E Press B STOP to stop playback at a marked
stop.
Press » PLAY to resume playback from a
marked stop.

| (INote.

» During playback, press NAVI to display the
Navigation menu, which features a list of options
for you to enjoy a customized viewing experi-
ence.
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Navigation
Menu

Press NAVI to display additional viewing options
during playback. For more information, please see
‘Introducing Navigation Menu’.

Before you start...

The options shown on the Navigation menu

« vary depending on the media types (e.g.
DVD, audio CD, VCD, etc.) as well as the
supporting features offered by the media being
played. Unavailable options will be disabled.

Subtitle

This DVD recorder supports the text-based subtitles
when playing back MPEG-4 videos. Activate

the function to get the most out of your viewing
experience.

.“1 Important

If you would like the subtitle to be automatically
displayed when playback starts, please make sure
you have:

* Given a correct file name.

You need to give the same file names to video title
and subtitle file, so that the DVD recorder can
match one file with the other. For example, name
‘XXX.avi’ for the video title, and ‘XXX.txt’ for the
accompanied subtitle file.

* Placed the file in the same folder as the video itle,
or under an appropriate sub-directory.

In addition, you need to save the subtitle file either
in the same folder as the video title, or in a sub-di-
rectory which is given one of the following names:
SRT, SUB, SUBS, SUBTITLE or SUBTITLES.

Using Text-Based Subtitle

Press a ¥ to select ‘Subtitle’, then press
ENTER to go to the sub-menu.

Repeat
Shuffle Mode
Zoom

Search

A-B Repeat
Subtitle
Audio
Information
Exit

vVvvwvw

Press a w to switch on or off the subtitle
function, or to select an appropriate coding
system for displaying the subtitle correctly,
then press ENTER.

Press NAVI. again or repeatedly press ¢ to exit
the Navigation menu.

| (Note

 This function will be disabled, if not available.
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DivX® VOD

DivX"® VOD (video-on-demand) allows you to
download video files to your PC, which you can
watch either on your computer or on your TV. To
protect copyrights of these digital videos, the ser-
vice features an Internet-based copyright protection
system called DRM (digital rights management).
DRM safeguards copyrights through an online
authorization process. To watch DRM-protected
video files, you need to complete the registration
procedure.

%What You Need to Do:

Step 1: Applying for a user account

Step 2: Registering your DVD recorder
Step 3: Selecting your desired video files

Step 4: Playing the files on your DVD recorder

Step 1: Applying for a
User Account

To watch DRM-protected video files, you need to
register a user account on the DivX" website first.
For more information, please visit: http://www.
divx.com/vod.

Step 2: Registering Your
DVD Recorder

Checking Registration
Code

To register your DVD recorder, you will need to
acquire the recorder’s registration code.

Press SETUP to display the Setup menu.

Press a ¥ to select ‘Playback’, then press »
to enter the sub-menu.

Press a ¥ to select ‘DivX(R) VOD’, then
press ENTER.

Press ENTER to display the registration
information.

SETUP Playback

o

DivX(R) Video On Demand

Your registration code is : BBKBJGWE

To learn more visit www.divx.com/vod

=1 N

Done

Ein

The registration code of your DVD recorder will appear.
(The code seen above serves as an example only.)

When completed, press SETUP to exit the
Setup menu.
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Registering Code Online

After you acquire the ID code, go to the DivX"
website, and enter the recorder’s registration code
in your account. When you finish filling in the
required details, you will then be directed to a film
download link. Follow the instructions given on the
website, and save the short film on a disc.

Playing Information Disc

To complete the registration process, you need to
play the disc which contains the downloaded film
on your DVD recorder.

Press 2 OPEN/CLOSE to open the disc tray.

Carefully place the disc in the tray with the
label side facing up, then press 2 OPEN/
CLOSE.

If playback does not start automatically, press
» PLAY to begin playback.

Your DVD recorder is then officially registered
when playback stops.

Step 3: Selecting Video
Files

Select the video files you would like to watch from
various online rental or retail shops. Normally,
users pay to get the viewing rights of these video
files, which are downloaded to users’ PCs. If you
would like to watch them on your TV, you need to
transfer these files to the recordable CD or DVD
discs.

| (Note.

» Conditions of viewing rights vary depending on
the service providers.

Step 4: Playing Video Files

Press 2 OPEN/CLOSE to open the disc tray.

Carefully place the disc in the tray with the
label side facing up, then press 2 OPEN/
CLOSE.

If playback does not start automatically, press
» PLAY to begin playback.

If the file is not protected by the DRM system,
playabck will then begin.

If the file is protected by the DRM system,
the system will check whether the DVD
recorder’s registration code corresponds to the
user account which holds viewing rights of the
video file.

E If you have purchased the file, playback will
then start.

If you have a rental file, a dialogue box show-
ing the remaining number of viewing rights
will appear. Press ¢ » to select ‘Yes’ or ‘No’,
then press ENTER.

View DivX(R) VOD Rental
This rental has 3 views left.

Do you want to use one
of your 3 views now?

Yes No




| @ Important]

 The editing functions are not applicable to video
titles saved on recordable and rewritable CDs
(CD-R/CD-RW).

 For video titles saved on recordable and
rewritable DVDs (DVD-R/RW and DVD+R/
RW), available editing functions may vary
depending on the disc format (minus or plus).

« If you do not finalize a disc before playing it on
other compatible devices, results of the editings
you have made on the disc will not be shown.

Please finish all editings before finalizing the
discs. You CANNOT apply the editing function
to a finalized disc, except in a DVD-RW disc
previously formatted in ‘Quick Preparation’
mode.

73

Supipy



Introducing Edit Menu

You can activate the Edit menu either by using the
Contents Menu or by pressing the EDIT button on
your remote control during playback.

Path 1: Using Contents Menu

1. Press CONTENTS to display the Contents
Menu.

2. Press « v 4 » to select the source medium,
then press ENTER.

3. Press ¢ » to select ‘Video’, then press ENTER.
4. Pressa v € » to select a video title.

5. Press EDIT to display the Edit menu.

The Edit menu will first be displayed with ‘Rename’,
‘Protect’, ‘Overwrite’ and ‘Erase’ buttons enabled.

You can use basic playback functions (shown in the bar
under the PIP window) on the Edit menu. When you press

» PLAY fto start playback, more function buttons will be
activated.

Path 2: Pressing EDIT Button during
Playback

1. Start playing back a title via the Contents Menu
or via DVD menu.

2. Press EDIT to display the Edit menu.

Rename TITLE 02
Protect off
Qverwrite off

@ Spiit

Merge
Erase

Set Thumbnail
W[« » o] @

g: } Chapter01 Insert Chapter Mark
E(:) 00 00:00:00 00:03:04 jide Chpater

Exiti :i

1. Indicates the PIP window, where the last image
of video title being played is shown.

2. Indicates the editing options for titles.
3. Indicates the selected thumbnail picture.

4. Indicates the original editing markings of
current title.

5. Indicates the progress bar for current title.

. Indicates the elapsed time for current title.
. Indicates the total time of current title.

. Indicates the editing options for chapters.

o 0 I &

. Indicates the ‘Exit’ function. Press to exit the
Edit menu.

P About ‘Title and Chapter’

For DVD-Video or other digital videos, disc
contents are usually divided into individual titles,
which you may preview using the disc menu.
Some titles may be further divided into a smaller
unit called ‘chapter’. To view the disc menu,
press MENU on the remote control to activate the
function.

Title & Title B
P \
- - \
- \
_ 7 Title B \
T T
| |
Chapter1 : Chapter2 : Chapter3
A A

.“1 Important

Manually or by default, this DVD recorder allows
you to add chapter marks in your recordings. De-
pending on the target medium you use, allowance
for maximum chapters and titles you can add may
vary. Please see the table listed below for details.

Per Title Per Disc
Media Maxi. Maxi. Maxi.
Chapter Chapter Title
HDD 999 NA 5994
DVD 99 254 49
99 (Music)
CD NA NA
98 (Video)
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Editing Titles

Naming a Title

Start playing back desired title via Contents
Menu or via disc menu.

Press EDIT to display the Edit menu.

On the Edit menu, press a ¥ to select
‘Rename’, then press ENTER.

EDIT

o W o x|
— Clear | i—

Cancel ‘ ‘ Space ‘ ‘ Finish ‘

o c x o
- < r @
N = 2T o
w x z O
2 < O m
uoN T T

You can also press number buttons on remote control to quickly
1 move to the column where your desired characters are situated.

(%, On-Screen Input Keypad (p.28)

Press « ¥ to select ‘Clear’, then press
ENTER before starting to enter the new name.

Press a » € » to select desired letters,
numbers or punctuation marks, then press
ENTER.

You can enter up to 30 characters for a title name.

E If you want to make changes during the pro-
cess, press a v 4 » to select ‘Back’, which
allows you to delete character by character in a
backward direction, then press ENTER.

If you want to delete all the characters you
have entered, press « v < » to select ‘Clear’,
then press ENTER.

If you decide not to change the original title
name, press « v 4 » to select ‘Cancel’, then
press ENTER.

When completed, press « v < » to select
‘Finish’, then press ENTER.

| (INote.

* This function is applicable to titles saved on
DVD discs and hard drive only.

* The entry bar CANNOT be left blank. If such
a condition occurs, you will not be able to exit
the keypad screen. Please follow the instruction
given in the pop-up dialogue box, and go back to
complete the process.

* Please pay extra attention when you name a title,
as the DVD recorder does not inhibit you from
entering same names for different titles.

Protecting a Title

You can protect the title from accidental erasure or
unplanned editings when you activate the ‘Protect’
function. When the function is switched on, the title
CANNOT be edited or erased. If you need to edit
it, you must unlock the file first.

Start playing back desired title via Contents
Menu or via disc menu.
Press EDIT to display the Edit menu.

On the Edit menu, press a ¥ to select
‘Protect’.

Rename TITLE 02
Protect Off
Overwrite Off
Split

Merge

Erase

Set Thumbnail

o]

Press ENTER to switch on or off the function.

Press a ¥ to select ‘Exit’, then press ENTER
to exit the setting.

E If you switch on the function, a lock icon will
be shown next to the protected title when you
return to the disc menu or Contents Menu.

TITLE O1 TITLE O
07:32PM 05/18/05 07:32PI
00:25:10 SP 00:25:1

| (INote.

 This function is applicable to titles saved on
DVD discs and hard drive only.
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Overwriting a Title

When you apply the function to a title, it will be
deleted and overwritten when you record new
title/program next time.

Start playing back desired title via Contents
Menu or via disc menu.
Press EDIT to display the Edit menu.

On the Edit menu, press « + to select
‘Overwrite’.

Rename TITLE 02
Protect Off
Overwrite Off
Split

Merge

Erase

Set Thumbnail

[on ]

Press ENTER to switch on or off the function.

Press a v to select “Exit’, then press ENTER
to exit the setting.

E If you switch on the function, a pen icon will
be shown next to the overwritten title when
you return to the disc menu or Contents Menu.

TITLEO1 TITLEO
07:32PM 05/18/05 07:32PI
00:25:10 SP & 00:25:1

| (Note.

« This function is applicable to titles saved on
DVD discs only.

e After the ‘Overwrite’ function is switched on,
new recording will be saved in the slot previously
occupied by the overwritten title. If the new
program lasts longer than the old one, it will be
recorded continuously. To prevent accidental era-
sure, it is suggested that you activate the ‘Protect’
function for the title immediately following the
overwritten one.

 Available recording time shown for the overwrit-
ten slot may not be exact, as it is likely to be
affected by the recording mode of the overwritten
title. It is suggested that you allow some flexibil-
ity when assigning new recording to this section.

Splitting a Title

Use this function to divide a title into two parts.
After being split, the new titles can be merged
again. You can use ‘Split’ and ‘Merge’ functions to
edit out commercials or scenes you would like to
skip to enjoy an interruption-free viewing experi-
ence.

Start playing back desired title via Contents
Menu or via disc menu.
Press EDIT to display the Edit menu.

On the Edit menu, press « ¥ to select ‘Split’,
then press ENTER.

Rename TITLE 02
Protect Off
Overwrite Off
Split

Merge

Erase

Set Thumbnail

[on ]

When the playback reaches the point where
you would like to set a dividing mark, press

a v to select ‘Split’, then press ENTER.

The title will be split into two new titles at where you press
ENTER during playback.

To split more titles, repeat steps 1 to 4. Or
press « v to select ‘Exit’, then press ENTER
to exit the setting.

| (Note.

 This function is applicable to titles saved on
rewritable DVD (DVD-RW/DVD+RW) discs and
hard drive only.

The split function is only applicable to video
titles longer than 6 seconds.

* You will not be able to split titles, if there are
already 49 titles or 99 chapters on your disc.
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Merging Two Titles into
One

Use this function to merge two titles into one, such
as two sections of programs before and after the
commercials. After being merged, the new title can
still be split again.

Start playing back desired title via Contents
Menu or via disc menu.
Press EDIT to display the Edit menu.

On the Edit menu, press « v to select ‘Merge
with’, then press ENTER.

Rename TITLE 02
Protect Off
Overwrite Off
Split

Merge

Erase

Set Thumbnail

[on ]

A menu showing all titles applicable for this
function will be displayed.

| EpIT

[&] Video

TITLE O1 TITLE 02 TITLE 03

| TITLE 04 TITLE 05

Ffoorl T T T T I T T 7T
e | Text Mode | Exit [IE]

Press « v 4 » to select the title to be merged
with, then press ENTER.

E To merge more titles, repeat steps 1 to 5. Or
press - v to select ‘Exit’, then press ENTER
to exit the setting.

| (INote.

 This function is applicable to titles saved on
rewritable DVD (DVD-RW/DVD+RW) discs and
hard drive only.

* For video titles recorded on a DVD+RW or a
DVD-RW disc, you can only merge the title with
its previous/next title and only when the previ-
ous/next title has the same recording quality, TV
signal, audio and video settings. Otherwise, the
function will not be applicable.

Protected and deleted titles CANNOT be
merged.

Erasing a Title

.‘g Important

Use this function to erase a title. Please note that
once erased, the title(s) CANNOT be retrieved.

Start playing back desired title via Contents
Menu or via disc menu.

Press EDIT to display the Edit menu.

On the Edit menu, press « v to select ‘Erase’,
then press ENTER.

Rename TITLE 02

Protect off

Overwrite off

Split ty

Merge =
~

Erase 3

')

Set Thumbnail

[on ]

The title selected will be erased.

To erase more titles, repeat steps 1-4. Or press
v to select ‘Exit’, then press ENTER to
exit the setting.

E After you complete the process, a deleted title
will be shown when you return to the disc
menu or Contents Menu.

DELETED TITLE O
07:32PI
00:25:10 SP 00:25:1

| (INote.

 This function is applicable to titles saved on
DVD discs and hard drive only.

* You CANNOT erase recorded title(s) on a DVD-
R or DVD+R disc if the disc is finalized.

* You CANNOT erase protected title(s).
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Setting a Title Thumbnail

Normally the first picture of a recording is used as
the indicating image. However, you can choose any
image from the recording as the indicator.

Start playing back desired title via Contents
Menu or via disc menu.
Press EDIT to display the Edit menu.

On the Edit menu, press a + to select ‘Set
Thumbnail’, then press ENTER.

Rename TITLE 02
Protect Off
Overwrite Off
Split

Merge

Erase

Set Thumbnail

L]

When desired image appears, press ENTER to
select it as the thumbnail picture.

To set thumbnails for other titles, repeat steps 1
to 4. Or press a v to select ‘Exit’, then press
ENTER to exit the setting.

[ONote|

* This function is applicable to titles saved on
DVD discs and hard drive only.

* You CANNOT set thumbnail image(s) for the
recorded title(s) on a DVD+R or DVD-R disc if
the disc is finalized.

* This DVD recorder captures images on an
interval basis, rather than frame by frame. As a
result, there may be a slight discrepancy between
the image selected and the image ultimately
shown as the thumbnail.

Editing Chapters

Inserting Chapter Mark

During playback you can insert chapter mark(s)
within a title.

Start playing back desired title via Contents
Menu or via disc menu.
Press EDIT to display the Edit menu.

On the Edit menu, press a w to select ‘Insert
Chapter Mark’, then press ENTER.

merge

Erase
L]

Set Thumbnail
Insert Chapter Mark

Remove Chapter Mark

%03:04 Hide Chapter

As the playback progresses, press ENTER at
desired point to insert chapter mark.

To insert more chapter marks, repeat step 4. Or
press - v to select ‘Exit’, then press ENTER
to exit the setting.

[ (INote

« This function is applicable to titles saved on
DVD discs and hard drive only.

* You can insert up to 99 chapter marks.

* The minimum time of a valid interval between
two chapter marks is one second. If you insert
two chapter marks within one second, only the
first command will be successfully executed.

» This DVD recorder captures images on an inter-
val basis, rather than frame by frame. As a result,
there may be a slight discrepancy between the
point selected and the point ultimately designated
as the chapter mark.

* You CANNOT insert chapter marks in recorded
title(s) on a DVD+R or DVD-R disc if the disc is
finalized.

Pressing EDIT during normal recording al-
lows you to add chapter marks in the recorded
session(s) manually.
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Removing Chapter Mark

During playback you can erase chapter mark(s)
within a title.

Start playing back desired title via Contents
Menu or via disc menu.

Press EDIT to display the Edit menu.

On the Edit menu, press a ¥ to select
‘Remove Chapter Mark’, then press ENTER.

verge
Erase
Set Thumbnail

Insert Chapter Mark

— Remove Chapter Mark
%:03:04 Hide Chapter

As the playback progresses, press ENTER at
desired point to remove chapter mark.

To remove other chapter marks, repeat step
4. Or press - ¥ to select ‘Exit’, then press
ENTER to exit the setting.

[ (Note

« This function is applicable to titles saved on
DVD discs and hard drive only.

¢ The first chapter mark within a video title CAN-
NOT be removed.

Hiding Chapter(s)

During playback you can hide chapters within a
title.

Start playing back desired title via Contents
Menu or via disc menu.

Press EDIT to display the Edit menu.

On the Edit menu, press « ¥ to select ‘Hide
Chapter’.

verge
Erase
Set Thumbnail

FL

Insert Chapter Mark
— Remove Chapter Mark
%03:04 Hjide Chapter

Press ¢ PREVIOUS or » NEXT to advance
to the previous or next chapter.

As the playback progresses, press ENTER at
desired point to hide a chapter.

E To hide more chapters within the title, repeat
steps 4 to 5. Or press a ¥ to select “Exit’, then
press ENTER to exit the setting.

[ONote|

* This function is applicable to titles saved on
DVD discs and hard drive only.

* You CANNOT hide chapters within recorded
title(s) on a DVD-+R or DVD-R disc if the disc is
finalized.

* On the Edit menu, a hidden chapter mark is
displayed in a darker color. A message ‘hidden’ is
also displayed at the left bottom corner of the PIP
window.

Showing Chapter(s)

During playback you can choose to show chapter(s)
currently hidden within a title.

Start playing back desired title via Contents
Menu or via disc menu.

Press EDIT to display the Edit menu.

On the Edit menu, press K4 PREVIOUS or M
NEXT to select the hidden chapter you would
like to show again.

You can press I PAUSE/STEP to pause playback before
you go on to step 3 and step 4 to show the hidden chapter.

Press a + to select ‘Show Chapter’, then
press ENTER.
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verge
Erase
Set Thumbnail

FL

Insert Chapter Mark
—— Remove Chapter Mark
2:03:04 'snow Chapter

To show more hidden chapters within the title,
repeat steps 3 to 5. Or press a v to select
‘Exit’, then press ENTER to exit the setting.

[ONote|

* This function is applicable to titles saved on
DVD discs and hard drive only.
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[ @ Important]

* You may only use this DVD recorder to repro-
duce or copy materials for which you own the
copyright; or have obtained permission to copy
from the copyright owner; or you otherwise have
a legal right to reproduce or copy. Unless you
own the copyright; or have obtained permission
from the copyright owner; or otherwise have
a legal right to reproduce or copy, you may be
violating the law, including copyright law, and
may be subject to payment of damages and other
remedies.

* This DVD recorder complies with ISO standard
for discs; therefore, it may not be able to let
you copy every file to discs if the number of file
directory level is more than seven in your source
medium. Nevertheless, all your files can still be
previewed through Contents Menu.

& Before you start...

Not all discs are compatible with high-speed
« copying. Check with the disc manufacturer for
compatibility.

Discs initialized on another recorder will not
« be able to be used for copying.

Check whether you select and insert a record-
« able disc.

., Guide to Using the Discs (p.93)
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One-Touch Gopying

The one-touch copying feature allows you to copy
files from a CD/DVD disc to hard drive and vice
versa. The DVD recorder will copy at the maxi-
mum speed possible.

Copying from Disc to Hard
Drive

Press CONTENTS to display the Contents
Menu.

Press a v < » to select ‘DVD’ as the source
medium, then press ENTER.

Press 4 » to select the file catalogue which
contains files you would like to copy, then
press ENTER.

Press a v < » to select the desired album or
file, then press COPY.

The copying process will then start.

& ] video J[J3] music [ Picture ] @0vD &
0
) )
Default ABJE) ~ 0515_100Q=)  0515_101

Current completness

1 36%

C ) [ [

0515_102§5)  O0515_103§Z)  0515_10445)
05/30 38 Files 05/30 45 Files 05/30 99 Files

001 J[002 I I | I I I |

e ]| Text Mode | Exit I

E If you would like to cancel the application,
press B STOP.

When completed, press CONTENTS to exit
the Contents Menu.

» Materials recorded on a VCD/SVCD disc

cannot be copied to the hard drive before the

disc is finalized.

 The title on the DVD-Video disc cannot be
copied from DVD to hard drive.

* The ‘One-Touch Copying’ function will not
be applicable, if any part of the title you
would like to copy is set to ‘Copy-Once’
protection.

Copying from Hard Drive
to Disc

Press CONTENTS to display the Contents
Menu.

Press a ¥ < » to select ‘HDD’ as the source
medium, then press ENTER.

Press 4 » to select the file catalogue which
contains files you would like to copy, then
press ENTER.

Press « v <« » to select the desired album or
file, then press COPY.

The copying process will then start.

&)] Video [ 03] Music [ Pictwre ]C @0DWD &
0
] IR
Default ABJE) ~ 0515_100Q=)  0515_101

— Current completness

[ T 1 36%

0515_102 =) 0515_103 [2) 0515_104 )
05/30 38 Files 05/30 45 Files 05/30 99 Files

001][002 I I I I I I |
I« H Text Mode Exit H "

E If you would like to cancel the application,
press B STOP.

* Once the copying is cancelled, the disc might
not be able to be used for recording again.

Lack of Storage Capacity
If during the process the DVD recorder
detects lack of storage capacity on your disc, a
dialogue box will appear.

[&] Video J[43] Music |C GHop 2

o= 5

D]

There is not enough space for backing up the contents.
Please insert another disc to continue or quit the
backup process.

| [1]] Picture

Insert Another Disc Quit Backup Process

T —— —
0515_103f2)  0515_10445)

05/30 38 Files 05/30 45 Files 05/30 99 Files
ootffoo2]l T T T I

ZH| Text Mode I Exit I

— T
0515_102 =)

Press < » to select desired application, then
press ENTER.

Wrong Format

If during the process the DVD recorder
detects an incompatible format on your disc, a
dialogue box will appear.
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& video | (53] Music | [ Picture ] © HOD &

ﬁ 1 [

The Function you specified is not supported due to
the mismatch of the disc format

Current Disc O\

Suggested Disc em
Insert Another Disc Quit Backup Process
0]
05/30 38 Files 05/30 45 Files 05/30 99 Files
corfoo2] I [ T [ T T 1T
e | Text Mode | Exit K]

Press ¢ » to select desired application, then
press ENTER.

E When completed, press CONTENTS to exit
the Contents Menu.

* Video files with ‘DVD-Video’ in file names
can only be copied to an emptied or new
DVD disc (DVD-R/RW and DVD+R/RW).

* Video files with “VCD’ in file names can
only be copied to a CD disc (CD-R/RW)
prepared in ‘VCD’ format.

* Video files with ‘SVCD’ in file names can
only be copied to a CD disc (CD-R/RW)
prepared in ‘SVCD’ format.

* CD-R/RW discs prepared in ‘Audio CD’
format can only be used to copy WAV music
files. When the copying is completed, you
need to finalize the disc first before playing it
on other compatible devices.

* If you copy recorded titles to a blank DVD
disc (DVD-R/RW, DVD+R/RW), you will
not be able to use the same disc to copy data
files, and vice versa.

Copying through Easy
Guider

You can also copy files using the Easy Guider
menu. For more information, please see ‘Using
Easy Guider: Copy’.
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Troubleshooting

Not every picture or sound problem is caused by a defect in your DVD recorder. Impairment can also be caused
by leads having been accidentally pulled out, damaged DVDs/CDs and worn-out batteries in the remote control.

If the following measures do not do not rectify the problem, consult an authorised dealer.

Problem

Possible Solution

Picture

No image shown on the
television screen.

Make sure the TV set is connected to the appropriate AUDIO/VIDEO,
SCART, S-VIDEO, or COMPONENT VIDEO OUT jacks on this
recorder.

Check whether the input setting of your TV set is correct.

Make sure a disc is properly placed on the disc tray, and is compatible
with your local TV system (NTSC or PAL).

Check whether the recorder is set to ‘progressive mode’ with an
incompatible TV. Reset the recorder by pressing » (direction button),
¢5°,¢0°, “2°, 0’, ENTER on the remote control.

Image shown with
noises.

Check if the disc is distorted or scratched.

If the video output signal from the recorder goes via VCR to your TV
set, or if you connect the recorder to a TV/VIDEO combination set,
the copyright protection code applied to some DVD programs could
affect picture quality. If you still experience this problem even when
you connect the recorder to TV, try connecting your recorder to the
TV’s S-VIDEO output.

Image imported from
an external device is
distorted.

If the video signal from the external device is copyright-protected,
you need to connect the device directly to your TV.

Recording

Cannot record.

Check whether you have inserted a recordable disc.

Check whether the disc you insert has been formatted or prepared for
recording.

Check whether there is enough space on the disc.
Check whether the disc has been finalized.

Check whether you inserted a disc which has already been used for
recording on other DVD recorders.

Recording does not
start immediately after
pressing ® RECORD
button

This occurs as disc preparation process is taking place, which will last
for a short time. (Applicable to DVD+R/RW discs)
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Problem

Possible Solution

Timer Timer recording does not | * Check whether the system time is correct.
Recording work properly. * Check whether the timer program is accurately set to desired time slot
or channel.

* Check whether you have inserted a recordable disc.

* Make sure you switch off the DVD recorder to activate the Timer
Record function.

Recording result is not » Check whether there is a schedule overlap. If so, go to the Timer
completed. Record menu to make correction.

» Check whether there is enough space on your disc.

The timer program * The system does not delete timer program records. You have to
remains even after manually delete the records on the Timer Record menu.
recording finishes.

Sound No sound.  Check whether the audio cable is well connected.

 Check if the audio cable is damaged.

e Check whether the input source setting on the amplifier is correct.

 There is no sound when playback is paused or is under scanning mode
(even forwards at regular speed) or is set for slow motion.

Press » PLAY to resume regular playback.

« If'the audio signal does not come through the DIGITAL OUT jacks,
please check whether related settings (on System Setup menu) for the
composite audio output are correct.

The sound from the * Check whether the audio cable is well connected.
recorder is not presented |, oy jf he audio cable is damaged.
properly or is distorted.

* Make sure the amplifier/receiver or TV is set to the correct input and
the volume is switched on.

Playback Cannot play back record- | ¢ Check if the disc is required to be finalized.

ings using this recorder
or other players

Discs recorded with copy-once material cannot be played on non-
CPRM compatible players.

The recorder starts
playing the disc
automatically.

DVD-Video disc features an auto playback function.
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Problem

Possible Solution

Playback

No playback on DVD
recorder.

Check whether there is any recording on the disc.
Check whether the disc inserted contains playable files.
Check whether an unplayable disc is inserted.

Check whether the way you insert the disc is correct. Insert the disc
with the label side up. If there is no label on the disc, please check
with the disc retailer.

Check whether the disc’s region code is the same as that of the
recorder.

Check whether the parental control function is switched on. If so, you
have to unlock it first. (Default code for the function: 0000)

Check whether the cables between TV and DVD recorder are well
connected.

TV channels

TV channels cannot be
changed.

Switch the input signal source of the recorder to “TV’.
Check whether the antenna cables are connected correctly.

Check whether the channel scanning process for your TV is com-
pleted.

Others

The disc tray does not
open/close.

Contact your local dealer or local authorized service point.

The recorder stops at
‘HELLOQO’ status, and
does not respond to any
other commands.

Switch the recorder off and switch it on again. If the recorder still
does not respond to any commands, unplug the power cord, reconnect
it and switch the recorder on again. Contact your local dealer or
authorized service point, if the problem remains.
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Specifications

General Power Supply * AC 100~240V 50/60Hz
Power Consumption * Approx. 5S0W (operation)
Operating Temperature * +5°C to +40°C (+36°F to +104°F)
Operating Humidity * 5% to 80% RH
Dimensions (W/H/D) * 430 x 66 x 316 mm
Net Weight * Approx. 4.5 kg
Connections Video Input * Cinch (yellow) x 1
(Front Panel) . . .
Audio L/R Input * Cinch (white/red) x 1
DV Input * IEEE 1394 4-pinx 1
Connections RF Input * Coaxial x 1
(Rear Panel) .
RF Output » Coaxial x 1
SCART Input * CVBS/RGB in, Decoder x 1
SCART Output * CVBS/S-Video/RGB out x 1
Video Output * Cinch (yellow) x 1
Audio L/R Output * Cinch (white/red) x 1
Component Video Output * Y/Pb/Pr (green/blue/red) x 1
Progressive Scan Output * 576p output
Digital Audio Output * Coaxial x 1/ Optical x 1
Tuner TV Format * PAL-B/G, PAL-I/I or SECAM-L
Bilingual Broadcast * NICAM TV Audio
Video DA Converter  10-bit/27MHz
Performance
Composite Video Output * 1 Vpp 75 Ohm
Component Video Output * Y:1Vpp 75 Ohm
* Pb: 0.7 Vpp 75 Ohm
* Pr: 0.7 Vpp 75 Ohm
Video Recording | DVD+VR (HQ/SP/LP/EP mode), SVCD * MPEG-2
Format
DVD+VR (SLP mode), VCD * MPEG-1
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Video Recording | Media Mode Recording Time
Mode - -
80 GB Hard HQ (High Quality) * 16 hours
Drive
SP (Standard Play) * 32 hours
LP (Long Play) * 48 hours
EP (Extended Play) * 64 hours
SLP (Super Long Play) * 96 hours
Just Fit * Variable
4.7 GB HQ (High Quality) * 1 hour
Recordable
& Rewritable SP (Standard Play) * 2 hours
DVD LP (Long Play) * 3 hours
EP (Extended Play) * 4 hours
SLP (Super Long Play) * 6 hours
Just Fit * Variable
700 MB VCD * 68 minutes
Recordable
& Remabie SVCD * 34 minutes
DVD . :
Audio CD * 70 minutes
Audio DA Converter * 24-bit/96KHZ
Performance
Signal-Noise (1kHz) * >90dB
Dynamic Range (1kHz) * >80dB
Channel Separation (1kHz) * >110dB
Total Harmonic Distortion (1kHz) * <-65dB
Audio DVD+VR (HQ/SP/LP/EP/SLP mode) * Dolby Digital 2-channel
Recording
Format SVCD/VCD * MPEG-1 Layer 2
CD-DA * PCM
Audio Format Playable Formats * MP3
Supported - WMA
- Playback « WAV
« LPCM

Dolby Digital 2-channel
Dolby Digital 5.1 channel (digital out only)
DTS (only digital out)
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DVD-Video
DVD-R/-RW
DVD+R/ARW

Video CD (VCD)

Super Video CD (SVCD)
Audio CD

CD-R/-RW

Disc Types Playback
Supported

DVD-R/-RW
DVD+R/A+RW
CD-R/-RW

Recording

[ONote|

Additional Information for units sold in the UK.

Units sold in the UK are suitable for operation from a 240V ac, S0Hz mains supply.

The range of multi-system receivers is built to work in most European countries. However, the mains plug and socket system
for the UK differs from many European countries.

This appliance has been supplied with a fitted, non-removable, approved converter plug for use in the UK. This converter plug
is fitted with a 5A rated fuse.

In case this appliance is supplied with a moulded 2-pin Euro plug only, which is unsuitable for UK operation, this must be cut
off and immediately disposed of. An approved 13A, 3-pin UK plug should then be fitted by a qualified electrician.

Note:

The severed Euro plug must be destroyed to avoid a possible shock hazard should it be inserted into a socket elsewhere.

If a non-rewireable 3-pin plug or a rewireable 13A (BS1363) 3-pin plug is used, it must be fitted with a SA ASTA or BSI ap-
proved BS1362 fuse. If any other type of plug is used it must be protected by a SA fuse either in the plug, or at the distribution
board. If this type of plug becomes defective, ensure that the fuse is removed before disposal, to eliminate potential shock
hazard.

If it is necessary to change the fuse in the non-rewireable plug, the correct type and rating (SA ASTA or BSI approved BS1362)
must be used and the fuse cover must be refitted. If the fuse cover is lost or damaged, the lead and plug must not be used until
a replacement is obtained. Replacement fuse covers should be obtained from your dealer.

Important:

The wires in the mains lead are colour coded in accordance with the following code:

BLUE - NEUTRAL

BROWN - LIVE

As the colours of the wires in the mains lead of your appliance may not correspond with the coloured marking identifying
terminals in your plug, proceed as follows:

Connect the BLUE coloured wire to plug terminal marked with the letter “N” or coloured black.

Connect the BROWN coloured wire to the plug terminal marked with the letter “L” or coloured red.

In no circumstance must any of the wires be connected to the terminal marked with the letter “E”, earth symbol “4”, coloured
green, or green & yellow.
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Quick Reference

Giuide to Complete System Setup Menu

Menu Option Sub-menu Option | Description
System Video Output * SCART S-Video | This option allows users to select appropriate video
* SCART RGB output mode.
» Component
* Progressive
Clock Format * M/D/Y-12Hr This option allows users to select a preferred date/time
 D/M/Y-12Hr display format.
* Y/M/D-12Hr
* M/D/Y-24Hr
* D/M/Y-24Hr
* Y/M/D-24Hr
Date This option allows users to set/reset date for the DVD
recorder.
Time This option allows users to set/reset time for the DVD
recorder.
Auto Sleep « Off This option allows users to set/reset desired time slot
« 30 minutes before the DVD recorder automatically switches to an
« 60 minutes inactive mode.
* 90 minutes
* 120 minutes
Restore This option allows users to recover default setup of the
DVD recorder.
Language OSD Multiple This option allows users to select a preferred language to
Languages be displayed on screen.
Menu Multiple This option allows users to select a preferred language, if
Languages available, to be displayed on the menu page.
Audio Multiple This option allows users to select a preferred language, if
Languages available, to be adopted for the spoken language.
Subtitle Multiple This option allows users to select a preferred language, if
Languages available, for subtitle.
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Menu Option Sub-menu Option | Description
Playback Aspect Ratio * 16:9 Wide This option allows users to select appropriate viewing
e 4:3 Pan mode available on users’ own television sets.
* 4:3 L.Box
Parental Lock « Off This option allows users to enable the parental control
o 8: Adult function.
* 7:NC-17
* 6:R
* 5:PG-R
* 4:PG-13
* 3: PG
+2:G
+ 1: Kid Safe
Password This option allows users to set/reset password
(default: 0000).
Slide Time o Off This option allows users to set/reset the display interval
* Interval for each picture.
(3-99 Seconds)
VCD PBC * On This option allows users to enable/disable playback
o Off control function on VCD discs which adopt the VCD 2.0
standard.
DivX(R) VOD » Registration This option allows users to obtain the registration code of
the DVD recorder. (Select models only)
Recording Mode * HQ This option allows users to select appropriate recording
. SP mode of different quality and length.
« LP
* EP
» SLP
Chapter Mark o Off This option allows users to set/reset the division point for
« 5 Minutes recorded video files.
* 10 Minutes
* 15 Minutes
* 20 Minutes
25 Minutes
* 30 Minutes
Audio Digital Out « PCM This option allows users to select an appropriate audio
* Bit Stream signal output mode.
DTS Out * On This option allows users to enable/disable the DTS
. Off (Digital Theater System) support offered by discs.
Surround * Stereo This option allows users to preset the sound effect for
 DOLBY DVD playback.
* DTS
TV Audio * Stereo This option allows users to preset the sound effect of TV
¢ Main programs.
* SAP (Sub)
* Mono
MPEG « PCM This option allows users to select an appropriate signal
o Bit Stream output mode.
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Menu Option Sub-menu Option | Description
TV Tuner Country Multiple Countries | This option allows users to select the appropriate area
where they are currently situated.
Utilities  Scan Channel This option allows users to set/reset TV channels.
+ Edit Channel
TV MODE * Bypass Allowed This option allows users to enable or disable the “TV
* Not Allowed MODE/SCART Bypass’ feature.
Exit This option allows users to exit the setup program.
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Guide to Using the Discs

Disc Types Supported

Application Disc Type Disc Logo Information
Flayback % DVD Preset DVD-Video discs (The regi
DVD-Video rese. 1= ideo discs (The region
VIDEO code is printed on the rear of recorder).
m m DVD+R/A+RW discs written in DVD-
Video format and finalized, or with
+R/+
DVDFRARW JPEG/BMP/MP3/WMA/WAV/MPEG-
DVD+R DVD+ReWritable 4 files.
DVD-R/-RW discs written in DVD-
D v D Video format and finalized, or with
DVD-R/-RW % ’
R JPEG/BMP/MP3/WMA/WAV/MPEG-
R4.7 RW
4 files.
COMPACT CDs for video files recorded with CD
Video CD (VCD) [] Dg@ sound, VHS quality, MPEG-1 compres-
sion technology.
Super Video CD [] COMPACT CDs for video files recgded with
(SVCD) CD sound, SVHS quality, MPEG-2
compression technology.
COMPACT CDs for music files recorded in digital
Audio CD [_[]—r DS@ signal', feat.uring better audig qua.lity,
less distortion and less deterioration of
DIGITAL AUDIO . . .
audio quality over time.
COMPACT COMPACT Finalized CD-R-/RW discs recorded
CD-R/-RW @DS@ @I] S@ in.Audio CD or Video CD formats, or
Recordable RIS with JPEG/BMP/MP3/WMA/WAV/
MPEG-4 files.
Recording / M
Timer Recording DVD-R/-RW e — DVD-R/-RW discs in DVD+VR format
Rl}..7 RW
+R/+ iscs i +
DVD+R/ARW m m DVD+R/+RW discs in DVD+VR
format
DVD+R DVD+ReWritable
CDMPACT [_ﬂrlCOMPACT
CD-R/-RW |] g @ [I 5 @ CD-R/-RW discs in MPEG-1/MPEG-2

e (ReWritable]

video format or in PCM audio mode

[ONote]

* The DVD-Video/DVD+RW/DVD+R/DVD-R/DVD-RW/CD-R/CD-RW/DVD-R logos are trademarks of the

respective companies.

* For best results, use discs with the above logos. This DVD recorder may not play back other discs correctly.
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Do not use irregular-shaped discs (e.g. heart-shaped), as these can damage the recorder.

+ It may not be possible to play CD-R, CD-RW, DVD-R, DVD-RW, DVD+R, DVD+RW in all cases due to the
type of disc or condition of the recording.

.“1 Important

Unplayable Disc Types

This DVD recorder does not play back the disc types listed below. If you try to play back these discs, excessive
noise may cause damage to your speakers. When placing an unplayable disc on the disc tray, the DVD recorder
will display ‘Invalid Disc’ on the display panel after attempts of trying to load the disc fail.

 Unfinalized discs from other DVD/CD recorders

* DVD Audio discs

* PHOTO CDs

* DVD-Video discs with a region code not supported by the recorder

« DVD-RAMs

* Data discs (e.g. CD-ROMs, DVD-ROMs) without files supported by this DVD recorder
+ Standard SACDs (Hybrid type of SACDs can be played as normal Audio CDs.)

Disc Format

Disc Type Application Format

VCD

SVCD
CD-R

Audio CD

Data CD*

CD
VCD

SVCD
CD-RW

Audio CD

Data CD*

DVD+VR
DVD-R

Data CD*

DVD+VR

DVD-RW
Data CD*

DVD
DVD+VR

DVD+R

Data CD*

DVD+VR
DVD+RW

Data CD*

* For media data files
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Disc Finalization

Content

Disc Finalization Recording after Finalization
Type
Data file Not required N/A
DVD-R
DVD+VR Required No
Data file Not required N/A
Full
DVD-RW e Not Required | N/A
DVD+VR Preparation
Quick Preparation | Required Yes
Data file Not required N/A
DVD+R
DVD+VR Required No
Data file Not required N/A
DVD+RW
DVD+VR Not required N/A

Guide to Media Files Supported

Media File Formats Supported

Application Category Formats (extension)
MPEG-1
Video MPEG-2 (.VOB/ .DAT/ .MPG)
MPEG-4 ((AVI/ .DIV/ .DIVX/ .MP4)
Playback
Music .MP3/ . WMA/ .WAV
Picture JPEG (.JPG)/ .BMP

 If an MP3 file name includes two-byte character, it may be displayed correctly.
* This DVD recorder does not support ID3 (for MP3) and WMA tags.

* This DVD recorder does not support MP3-Pro files.

* The MP3 file bitrates supported by this DVD recorder are: 32Kbps - 320Kbps.
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Giuide to Recording Options

Recording Mode

Media Mode Recording Time
80 GB Hard HQ (High Quality) 16 hours
Drive
SP (Standard Play) 32 hours
LP (Long Play) 48 hours
EP (Extended Play) 64 hours
SLP (Super Long Play) 96 hours
Just Fit Variable
4.7 GB HQ (High Quality) 1 hour
Recordable
& Rewritable | SP (Standard Play) 2 hours
DVD LP (Long Play) 3 hours
EP (Extended Play) 4 hours
SLP (Super Long Play) 6 hours
Just Fit Variable
700 MB VCD 68 minutes
Recordable .
& Rewritable SVCD 34 minutes
&y Audio CD 70 minutes

[ONote]

» The ‘Just Fit’ mode is available for timer recording only.

Timer Recording Frequency

Recording Frequency

Suitable Applications

Once To record program broadcast during specific time slot.
Daily To record program broadcast every day during specific time slot.
Weekly To record program broadcast on certain day(s) every week during

specific time slot.
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A 4 Quick Reference
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Glossary

480i/480p

Indicates the number of scanning lines and scan-
ning format of an image signal.

480i indicates 480 scanning lines with interlace
format, and 480p indicates 480 scanning lines with
progressive format.

576i/576p

Indicates the number of scanning lines and scan-
ning format of an image signal.

5761 indicates 576 scanning lines with interlace
format, and 576p indicates 576 scanning lines with
progressive format.

Aspect Ratio

Aspect ratio refers to the length to height ratio of
TV screens. The ratio of a standard TV is 4:3, while
the ratio of a high-definition or wide TV is 16:9.
The letter box allows you to enjoy a picture with a
wider perspective.

Bit Stream

The digital form of multi-channel audio data (e.g.,
5.1-channel) before it is decoded into its various
channels.

Chapter / Title

Chapter is the smallest division and title is the
largest division on a DVD VIDEO. A chapter is a
division of a title and similar to a track for Video
CD or Audio CD.

Component Video

Video signals with three channels of separate
information that makes up the picture. There are
some types of component video, such as R/G/B and
Y/Cb(Pb)/Cr(Pr).

Composite Video

A single video signal commonly used in most con-
sumer video products that contains all luminance,
color, and synchronization information.

DivX® VOD

DivX® VOD (video-on-demand) service is designed
to protect copyrights of digital videos. Through an
online registration process, DivX® VOD prevents
unauthorized downloads or file sharing. For more
information, please visit: http://www.divx.com/vod.

Dolby Digital®

A six-channel system consisting of left, center,
right, left rear, right rear and LFE (Low-Frequency
Effect channel, for use with a sub-woofer) chan-
nels. It requires a Dolby Digital® decoder, either in
the player or in an external receiver to regenerate
the sound. All processing is done in the digital
domain. Not all Dolby Digital discs contain six
(5.1) channels of information.

DTS® (Digital Theater Systems)

DTS® stands for Digital Theater Systems. DTS®

is a Digital Surround audio encoding format
configured with six (5.1) channels, similar to Dolby
Digital®. It requires a DTS® decoder, either in the
player or in an external receiver to regenerate the
sound. All processing is done in the digital domain.
Not all DTS discs contain six (5.1) channels of
information.

DVD-R

DVD-R is a recordable disc that is the same size as
a DVD-Video. Contents can be recorded only once
to a DVD-R, and will have the same format as a
DVD-Video.

DVD-RW

DVD-RW is a recordable and rewritable disc that
is the same size as a DVD-Video. DVD-RW has
two different modes: VR mode and Video mode.
DVD created in video mode has the same format
as a DVD-Video ,while discs created in VR
(Video Recording) mode allow the contents to be
programmed or edited
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DVD+R

DVD+R is a recordable disc that is the same size as
a DVD-Video. Contents can be recorded only once
to a DVD+R, and will have the same format as a
DVD-Video.

DVD+RW

DVD+RW is a recordable and rewritable disc.
Recording can be erased and you can record on the
same disc again for the maximum of 1,000 times.
DVD+RW use a recording format that is compa-
rable to a DVD-Video format.

Interlace Output

NTSC, the video signal standard, has 480 interlaced
(I) scan lines, The Interlaced scanning system
places lines of the second half of the picture
in-between lines of the first half of the picture.

JPEG

A popular file format for still image compression
and storage. JPEG stands for ‘Joint Photographic
Experts Group’ There are two sub-types of the
JPEG format as follows.

Baseline JPEG: used for digital cameras, the web,
ete.
Lossless JPEG: an old type, rarely used now.

Linear PCM Audio

PCM stands for ‘Pulse Code Modulation’. Linear
PCM is the usual method for digitally encoding
audio without compression, and is used for the
audio tracks on DVD VIDEO discs, Audio CDs,
etc.

MP3

MP3 (MPEGI audio layer 3) is a compressed
audio file format. Files are recognized by their file
extension .mp3 or .MP3.

MPEG

MPEG stands for ‘Motion Picture Experts Group’.
This is an international standard for compression of
moving images. On some DVDs, digital audio has
been compressed and recorded in this format.

NTSC
(National Television System Committee)

The initials stand for National Television Standards
Committee. This is the committee that established
the standards for television systems in the United
States. The NTSC standard broadcasts 525 or 480
lines of resolution per second, and 30 frames per
second of refresh rate, 60 Hz field frequency. NTSC
TV system is widely used in USA, Canada, Latin
America and Taiwan etc.

PAL (Phase Alternation by Line)

PAL (Phase Alteration Line) is the color television
broadcast standard throughout the Western Europe
(except in France, where SECAM is the standard),
Australia, China, Singapore and Malaysia etc.

It has 625 lines of vertical resolution per second
and 25 frames per second refresh rate, 50 Hz field
frequency.

PBC

Playback Control. A special feature on a Video CD
or Super VCD that enables interactive use.

S-Video

A video signal which improves picture quality over
standard composite connections. Used on Super
VHS, DVD, high end TV monitors, etc.

Track

SVCD, VCD, Audio CD discs use tracks to divide
up the content of a disc.

WMA

WMA stands for ‘Windows Media Audio’, an audio
codec standard proposed by Microsoft. Music/au-
dio files which are compressed using this standard
come with the file extension, .wma or WMA.
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